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1 Environment and Tools Required

 Microsoft Windows (any version, as far as we are aware)
 Text editor (e.g. WordPad, NotePad, NotePad++) that enables you to read and edit ASCII

text files.
 A tool like WinZip that can  uncompress.zip files  (not needed with recent versions of

Windows)
 Microsoft  Access  may be  useful  if  you want  to  examine Access  tables,  but  it  is  not

essential.  It is included in Microsoft Office 365, but not in all versions of Office.  The
SWAT Editor provides all the needed editing features of Access tables.

System requirements for SWAT Editor Version 2012.10.23
 Microsoft Windows XP to 10
 Microsoft .Net Framework 3.5
 Adobe Acrobat Reader Version 7 or higher. Acrobat Reader may be downloaded for free

from: http://www.adobe.com/products/acrobat/readstep2.html 

2 Installation

There are three versions of QSWAT3, named QSWAT3, QSWAT3_64 and QSWAT3_9.  
QSWAT3 is a 32 bit application, and QSWAT3_64 and QSWAT3_9 are 64 bit.  The choice of 
which to install is based primarily not on whether your computer is 64 bit or 32 bit, but on which
version (if any) you have of Microsoft Office.  QSWAT3 needs an 'Access database engine' to be 
installed for it to run, and this engine has to match your version of Microsoft Office.  To be 
precise:

1 If you don't have Microsoft Office then your choice of 32 bit or 64 bit is made according 
to your computer.

2 If you have a 32 bit version of Microsoft Office then you need to install a 32 bit version 
of QGIS, QSWAT3, and the 32 bit Access database engine.

3 If you have a 64 bit version of Microsoft Office then you need to install a 64 bit version 
of QGIS, either QSWAT3_64 or QSWAT3_9, and the 64 bit Access database engine.

If you are not sure if your computer is 32 or 64 bit, see if you have a folder C:\Program Files
(x86).  If you have, your computer is 64 bit: this folder is where 32 bit applications are typically
stored on 64 bit machines.

If you have a 64 bit computer and are not sure whether your copy of Microsoft Office is 32 or 64
bits, right click on your desktop icon for one of the office tools, e.g.Word, and select Properties.
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Look in the  Shortcut tab at the path in the box labelled  Target.   If it starts  C:\Program Files
(x86)\Microsoft Office then it is 32 bit.  If it starts C:\Program Files\Microsoft Office then it is 64
bit.

The choice between QSWAT3_64 and QSWAT3_9 on 64 bit machines depends on what version
of QGIS you want to run.  QGIS 3.16 came in two versions, one with a .exe installer, and one
with a .msi installer, the MSI version.  All releases from 3.20 onwards will only come as an MSI
version.  The two are not compatible, since .exe installed versions use Python 3.7, while MSI
installed versions use Python 3.9.  Since .exe versions are no longer being produced, it is sensible
to install QGIS 3.22 (the current long term release) along with QSWAT3_9 unless you need to
carry on using an older version to ensure consistency in an existing project.  Projects created on
older versions of QGIS will run on newer versions, though you will get a warning that the newer
version will change the project file and it probably will not reload on an older version.  If in
doubt, make a copy of everything before you switch.

SWAT projects built on one computer and transferred to another with a different bit size will run
quite happily.  But it is possible that the numbering of subbasins and HRUs may differ if you
rerun watershed delineation or HRU creation.

In the rest of this document we will use QSWAT3 to apply to both QSWAT3, QSWAT3_64 and 
QSWAT3_9 except where we need to distinguish between them.

 Install QGIS3 by going to the  QGIS download page and selecting a long term release
standalone installer.
This gives you an executable file which you run to install  QGIS3.  Use the default folder
C:\Program Files (x86)\QGIS 3….  or C:\Program Files\QGIS 3….  as the installation
folder.   Note that it  is essential  that you select QGIS3 rather than the earlier QGIS2,
because they use different versions of the Python language.  We recommend that you
select a long term release version of QGIS because that is  the one we test  QSWAT3
against.  From now on we will use Program Files as a folder name, even though it may
be Program Files (x86) on a 64 bit machine.

 You may already have a SWAT Editor 2012 if you are an ArcSWAT or QSWAT user, and
if  so  you do not  need  to  install  a  new one,  unless  you want  to  update  your  SWAT
executable.  
If you do want to install SWAT Editor 2012 version, you should put it in its standard
place  C:\SWAT\SWATEditor.  For the SWAT 2012.10.23 version,  unzip the installation
archive  Swateditor_Install_201210_723.zip  (or  a  later  version  if  available  from
http://swat.tamu.edu/software/arcswat/swateditor/)  and  double-click  on  the  "setup.exe"
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program to install the SWAT Editor. This will launch the SWAT Editor install program.
Use the default folder C:\SWAT\SWATEditor as the installation folder. 

The  SWATEditor  folder  will  consist  of  Databases  folder,  SwatCheck  folder,
SWATEditorHelp, and other SWAT executables. The database folder consists of SWAT2012
databases which require updating based on user available information (e.g. user soil, weather
generator).  Refer  to  Appendix  I (page  78)  on  how  to  update  a  database.  Refer  to  the
SWATEditor_Documentation.pdf document in SWATEditorHelp for important information
on how to get started with the SWAT Editor.

If you already have a SWAT Editor 2012 because you are currently using QSWAT (with
QGIS2) or ArcSWAT then you do not need to install the latest one, and you may prefer not to
if you are in the middle of a project, as the latest one may well have a different version of the
SWAT executable: it currently comes with version 681.

Make sure you have the system requirements  listed above for the SWAT Editor  to work
properly. Failure to have the above system configuration may result in failure to install the
SWAT Editor or errors in the SWAT Editor interface.

Users can join the user group for help at https://groups.google.com/forum/#!forum/qswat
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Figure 1: SWAT Editor installation folder (after installing QSWAT3)

 Install  QSWAT3  by  running  QSWAT3install12.0.0.exe,  or  QSWAT3_64  by  running
QSWAT3_64install12.0.0.exe, or QSWAT3_9 by running  QSWAT3_9install2.0.0.exe,
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or a later version. This adds some files to the SWATEditor:  a project database and a
reference database in Databases, and also stores the TauDEM executables in a new folder
C:\SWAT\SWATEditor\TauDEM539Bin.
You  are  given  a  choice  to  install  QSWAT3  just  for  yourself  or  everyone.   It  is
recommended to choose the first, and this causes the QGIS plugin QSWAT3 to be put
into the user's home folder as
 AppData\Roaming\QGIS\QGIS3\profiles\default\python\plugins\QSWAT3  or  AppData\
Roaming\QGIS\QGIS3\profiles\default\python\plugins\QSWAT3_64  or  AppData\
Roaming\QGIS\QGIS3\profiles\default\python\plugins\QSWAT3_9,  which  we  will  refer
to  as  the  QSWAT folder.   If  your  machine  is  used  by other  people,  each  can  install
QSWAT3, or  you can take the other choice, and QSWAT3 is then installed in Program
Files  as  QGIS  3.22.12\apps\qgis-ltr\python\plugins\QSWAT3  (or  QSWAT3_64  or
QSWAT3_9).  The path will depend on the QGIS version number.
The disadvantage  of  doing this  is  that  if  you ever  reinstall  QGIS,  QSWAT3 will  be
deleted and will need to be reinstalled.  You will also need administrator privileges.

The latest version of QSWAT3 or QSWAT3_64 or QSWAT3_9 can be downloaded from
the SWAT website http://swat.tamu.edu/. 

 Install  Microsoft  Access  Database  Engine  2016  Redistributable from
https://www.microsoft.com/en-us/download/details.aspx?id=54920.   Choose
accessdatabaseengine.exe for a 32 bit installation, accessdatabaseengine_X64.exe for 64 bit.
If you have made a mistake and the database engine does not match your Microsoft Office,
you will be invited to uninstall Office in order to install the database engine.  Needless to say,
do  not  uninstall  Office:  install  the  other  engine  and  if  necessary  install  the  appropriate
versions of QGIS and QSWAT3. 

2.1 Can I use QSWAT3 at the same time as QSWAT?

Yes.  You can have both QGIS3 and QGIS2 installed, and both QSWAT and QSWAT3 installed.

2.2 Can I run QSWAT3 on a QSWAT project?

Yes.  A QSWAT project will load into QGIS3 and run with QSWAT3 without problems.  You will
get a warning when you open the project that the project file is from an old version of QGIS.  If 
you save the project (and this will happen if you do it explicitly or when you click OK in the 
main QSWAT3 form) then the project file will be updated to QGIS3 format.  This will probably 
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open in QGIS2 again (though you have to unzip it first as QGIS3 saves project files in a zip 
archive with suffix .qgz that contains the project file with suffix .qgs that QGIS2 needs) but the 
results will not be perfect.  If you want to continue using QGIS2/QSWAT while exploring 
QGIS3/QSWAT3 it is a good idea to copy the project and project file to a separate location first.
If you run watershed delineation or HRU creation in QSWAT3 on a QGIS2/QSWAT project then 
subbasin numbers and HRU numbers may change, especially if you are using QSWAT3_64 or 
QSWAT3_9.

2.3 File Explorer settings: a couple of hints

You are strongly advised to adopt a couple of settings in File Explorer (the tool you use to find 
files and folders in Windows).  Open File Explorer, select the View tab, and in the Show/hide 
section check File name extensions and Hidden items.  You can see these settings at the top right 
of Figure 1.

The first of these is useful because it makes it easy to see what kind of file you are selecting.  In 
particular, if you have a shapefile X, say,  it comes as a number of files, including X.shp and 
X.shp.xml.  If you have not made file name extensions visible these will appear as X  and X.shp 
respectively, and it will be very easy to choose the second rather than the first when loading a 
shapefile into QGIS.

The second is useful because your AppData folder will otherwise not be visible, and if you ever 
need to access any file in the QSWAT3 plugin, in what we are calling the QSWAT folder,  you 
will not be able to find it.

3 Structure and Location of Source Data

Before starting QGIS, users should prepare their tabular and spatial data according to QSWAT3
requirements. Users can refer to Appendix I (page 78) on preparing tabular data (e.g. preparing
soil and climatic data). All the spatial data (DEM, land use and soil) should be projected into the
same projected coordinate system. Users can refer to Appendix II (page 85) for preparing global
data for QSWAT3. Users can also refer to the Arcswat Interface for SWAT2012 User’s Guide
(pages 11-36) for detailed guidance. The example files used in this manual are available in the
QSWAT folder in a folder ExampleDataset. This folder contains:

 A DEM in folder DEM 

 A stream reaches file to burn in to the DEM, in folder RobitStreams 

 An outlet file in folder MainOutlet

 Landuse and soil maps in directories Landuse and Soil 
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 Climate data in folder ClimateRobit 

 Some Excel and csv files for making database tables, and

 An observed data file observedFlow.csv  in folder Observed.

It is a good idea while following this guide to add the ExampleDataset folder to your Favorites
or Quick Access list, as we will be regularly accessing files within it. 

4 Structure and Location of Output Data
We will  be  establishing  a  project  called  Demo,  say,  in  a  folder  C:\  QSWAT_Projects\Robit\
Demo.. This will create:

1 In the  folder  C:\QSWAT_Projects\Robit the project  file  Demo.qgs (or  .qgz) and a
folder Demo.  If we later want to reopen the project Demo.qgs will be the file we look
for.   The folder Demo is the project folder.

2 A  folder  C:\QSWAT_Projects\Robit\Demo\Scenarios\Default\TxtInOut  that  will
contain all the SWAT input and output files.

3 A folder  C:\QSWAT_Projects\Robit\Demo\Scenarios\Default\TablesIn that  may  be
used by the SWAT Editor.

4 A folder  C:\QSWAT_Projects\Robit\Demo\Scenarios\Default\TablesOut that may be
used by the SWAT Editor and is used to hold results files from visualisation.

5 A folder C:\QSWAT_Projects\Robit\Demo\Source that will contain copies of our input
maps and a number of intermediate maps generated during watershed delineation.

6 If we choose to save a SWAT run as  Sim1, say, then a folder  C:\QSWAT_Projects\
Robit\Demo\Scenarios\Sim1 will  be  created  (a  copy  of  C:\QSWAT_Projects\Robit\
Demo\Scenarios\Default, including its sub-folders).

7 A folder C:\QSWAT_Projects\Robit\Demo\Watershed with several sub-folders

5 Setup for Robit Watershed, Lake Tana Basin

1 Start  QGIS and  select  Plugins menu  →  Manage  and  Install  Plugins and  find
QSWAT3  (or QSWAT3_64  or QSWAT3_9).  Click its checkbox to install, which
takes a few seconds. The SWAT icon will appear in the toolbar.  If it fails to appear
you are probably running the wrong version of QSWAT3, 32 bit instead of 64 or vice
versa.
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Figure 2; QGIS with the SWAT icon 

2 Start QSWAT3 by clicking the SWAT icon.
3 The main QSWAT3 interface will be displayed. Click the box New Project.
4 A browser will be displayed requesting a name for the new project. Type  Demo in the

text box labelled  File name (under the  C:\QSWAT_Projects\Robit folder). See  Figure 3.  Click
Save.

Figure 3: Creating a QSWAT3 project
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At this stage all your maps should be prepared in an equal area projection (probably, but not
necessarily, UTM1). All the maps should be in the same projection coordinate system. 

The interface now presents a step-by-step configuration to be followed in order to prepare the
SWAT simulation, starting with Step 1 (Figure 4).

Figure 4: Step 1 interface

5 At this stage the project database is created as Demo.mdb in the project folder, and a copy
of the SWAT reference database QSWATRef2012.mdb is also created there. For this example you
need to update the reference database with details of the soil data we are using and also possible
weather generation stations.  Refer to Appendix I (page 78) on how to do this.. 

5.1 Watershed Delineation
6 To start automatic watershed delineation click the  Delineate Watershed button. When
the Delineate Watershed form opens, click the button on the right under Select DEM.

1  UTM is not an equal area projection, but is close to being so, and sufficiently close for SWAT to use on most 
watersheds.
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7 Browse to  the  ExampleDataset\DEM\srtm_30m folder  and open the file  hdr.adf.  This
digital elevation map (DEM) is an ESRI grid and consists of a number of files. The file called
hdr.adf is the one to choose for such a grid.  DEMs are raster files (also called grids) and come
in a large variety of formats.  A common format is GeoTiff, when you would be looking for a
file with suffix .tif.  Click Open.

Figure 5: Selecting the DEM

8 The path  of  the  elevation  map raster  will  be  displayed in  the  Select  DEM text.  The
selected DEM has been copied to the projects  Source folder  and,  if  necessary,  converted to
GeoTiff format (.tif). If your DEM's units are not metres you can select the DEM properties tab
and change them. This tab also shows the DEM cell size, cell area, projection system and extent
in degrees. 
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9 Users can burn in an existing stream network using the option Burn in existing stream
network;  use a file with the extension  *.shp (Figure 6).  Check the  Burn in existing stream
network option and select the file
 ExampleDataset\RobitStreams\robReach.shp.

The delineation form allows you to opt for a  predefined watershed and stream network by
selecting the Use existing watershed tab. If you are interested in using a predefined watershed
and stream network please refer to Appendix III (Using a Predefined Watershed and Stream
Network, page 97). 

We will not use MPI, which enables multiprocessing during watershed delineation (see Appendix
IV, page 100) and so the Number of processes spinbox should be set to 0.
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Figure 6: Creating stream networks

10 The threshold size for creating subbasins should be set next. It can be set by area, in
various units such as sq km or hectares, or by number of cells.  If necessary, change the threshold
method to use hectares, change the number of hectares to 90, and press  Create Streams: the
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number of cells will be adjusted to the corresponding value (1000). The threshold is the number
of cells (or area) required to form a stream: a cell will be made part of a stream if it has at least
the threshold number of cells draining into it. Stream reaches are sections of the stream network
between significant points, where significant points are stream sources, stream junctions, and
inlet, outlet,  point source, and reservoir points that we may add later.  A subbasin is an area
draining into a stream reach. This step creates streams (Figure 7). It also loads the stream burn-in
shapefile if it was selected.  

Figure 7: Stream networks displayed

11 An inlets/outlets file containing just a main outlet is provided for this example. Check the
Use an inlets/outlets shapefile option, and browse to MainOutlet/MainOutlet.shp

12 Users  can  add  outlets,  reservoirs,  inlets,  and  point  sources  by  selecting  the  Draw
Inlets/Outlets option. This first asks if you wish to add to the existing inlets/outlets file, or create
a new one. Having made this choice, select the type of point to add, and click on the map to
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place it at the appropriate place. Points need to be placed on the stream network, and you may
need to zoom in to place them precisely. Only points within the snap threshold of a stream reach
will be counted as points. Click OK to confirm and exit, and Cancel to remove points and exit.
If you choose to draw, a new file,  drawoutlets.shp  is created in the  Watershed\Shapes  folder,
which may be used again. See  Appendix III (page  97) for details of the fields needed in an
inlets/outlets file.  We do not add any additional outlets, reservoirs, inlets, or point sources in this
example.
  

Figure 8: Step where Inlets/Outlets are added.

13 If you have several points in your inlets/outlets file you can choose to use just a selection
of them. To do this choose the Select Inlets/Outlets option. Hold Ctrl and select the points by
clicking on them. Selected points will turn yellow, and a count will be shown at the bottom left
of the main window (Figure 9). You only need to use this option if you want to only use a subset
of outlets.  The default is to use all the points in the outlets file or those drawn.
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Figure 9: .Inlets/outlets selected

14 Clicking  Create  Watershed will  create  the  watershed  (Figure  10).   The  Delineate
Watershed form states how many points were snapped successfully to streams, and how many
(if any) failed.  Our form stated 1 snapped, as expected.  If you have a number of points, and
some fail,  clicking  Review snapped will add to the map a shapefile containing the snapped
points, while hiding the original inlets/outlets file.  Points which disappear rather than moving
slightly are those that failed, and need to be shifted closer to a stream.  Or you can try Create
Watershed again with an increased snap threshold.
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Figure 10: Delineated watershed

15 In  QSWAT3  users  can  select  and  merge  subbasins.  This  is  especially  important  in
avoiding small subbasins. To merge subbasins, select the option Select subbasins under Merge
subbasins. Hold the Ctrl key and click in subbasins you want to select. Selected subbasins will
turn yellow, and a count is shown at the bottom left of the dialogue window (Figure 11).  
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Figure 11: Step of merging subbasins

16 For the sake of this exercise, we will not merge the selected subbasin. Release the Ctrl
key and click on the map outside the watershed and the selected subbasin will be unselected.
Checking the option of Select small subbasins provides the option to merge subbasins below a
certain threshold (i.e.  either the area in hectares or a percentage of the mean subbasin area)
(Figure 12). For this exercise click the radio button percentage of mean area, and put 25 in the
box next to it. Click Select. It will show you subbasins that have an area less than 25% of the
mean  area.  When  finished  click  Save to  save  your  selection,  or  Cancel to  abandon  your
selection. You click Merge to perform the merge. Note: You cannot merge a subbasin that has an
outlet,  inlet,  reservoir,  or  point  source.   So in this  example,  the only small  subbasin is  that
nearest the watershed outlet, which cannot be merged, and QSWAT3 will report this.
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Figure 12: Small subbasins selected

17 Point sources can be added to all the subbasins by checking the option Add point source
to each subbasin (Figure 13). You can also add reservoirs to selected subbasins. You then need
to click  Add. Unlike points added earlier, these extra point sources or reservoirs do not create
subbasin boundaries, but are added to existing subbasins, provided they do not already have
point sources or reservoirs. Adding point sources to all subbasins is useful if you have several to
add. It is quite safe since only those you provide input data for will have any effect on the SWAT
simulation. We will not add point sources or reservoirs.  Uncheck  Add point source to each
subbasin, click Add, and they disappear: you may need to change the canvas in some way, eg
zoom in and out. for the change to be shown.
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Figure 13: Point sources added to each subbasin

18 Finish  delineation  by  clicking  OK.  This  causes  the  subbasins  to  be  numbered  and
calculates and stores information about the subbasins and streams. This step ends watershed
delineation, and enables the  Create HRUs option (Figure 14).  The  Create Watershed form
should disappear, but sometimes it remains and needs to be removed by clicking Cancel.
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Figure 14: Watershed delineation is completed, and Create HRUs is enabled

5.2 Create HRUs

19 Having calculated the basins you needed to calculate the details of the Hydrological 
Response Units (HRUs) that are used by SWAT. These are divisions of subbasins into smaller 
units each of which has a particular soil/landuse/slope range combination.

20 To do this we click Create HRUs, select ExampleDataset\Landuse\roblandusenew\
hdr.adf as the Landuse map, and select ExampleDataset\ Soil\mowr_soil90\hdr.adf as the Soil 
map.  As with other input maps, these will be copied into a subfolder of the project.  They do not
need to be converted to GeoTiff as the DEM was (a requirement of the TauDEM software).  If 
they are much larger than the DEM, then a cropped version is used as the copy.  In this example 
the soil file is much larger in extent than the DEM, and is cropped, and converted to a GeoTiff in 
the process.  These files do need to be rasters: if either is a shapefile you need to convert it to a 
raster for which you can use QGIS's Raster -> Conversion -> Rasterize tool.  For a more 
detailed presentation of how to do this, see the document Using SSURGO and STATSGO2 soil 
data with QSWAT which you can find on the QSWAT page of the SWAT website.  SSURGO and 
STATSGO soil data is used in the USA, and the maps are supplied as shapefiles.

21 We need lookup tables to convert from the numeric values found in the landuse and soil 
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maps to SWAT landuse codes and soil names respectively.  These lookup tables must be in the 
project database.  You can prepare these in advance, or use predefined ones like global_landuses 
and global_soils  intended for use with the corresponding global maps, or, as we will do here, 
use the option to import a comma separated values (.csv) file.  Lookup tables for landuse must 
have the string landuse in their names; lookup tables for soils must have the string soil in their 
names, or they will not appear in the pull-down menus Landuse table and Soil table 
respectively.

22 For landuse, select the option Use csv file in the Landuse table pull-down menu.  Make 
the same selection for Soil table. Make sure the Soil data option is set to usersoil.. The other soil
data options are for watersheds in the USA for which you are using STATSGO, STATSGO2, or 
SSURGO soil maps. To use STATSGO2 or SSURGO soil maps you will need to download 
SWAT_US_SSURGO_Soils.mdb from 
https://swat.tamu.edu/media/116649/swat_us_ssurgo_soils_2022-03-04.zip and install it in C:\
SWAT\SWATEditor\Databases. No soil lookup table is needed with STATSGO2 or SSURGO.

23 We will form HRUs based on slope as well as landuse and soil. We add an intermediate
point for slopes (e.g. 10) to divide HRUs into those with average slopes in the range 0-10% and
those with average slopes above 10%. Type 10 in the box and click Insert. The Slope bands box
shows the intermediate limit is inserted. To generate the FullHRUs shapefile, click in the check
box. 
 
24 To read in the data from the DEM, landuse, soil and slope maps and prepare to calculate
HRUs, make sure  Read from maps is checked and click  Read  (Figure 15). There is also an
option  Read from previous run. This can be used when rerunning the project, provided you
have not rerun the delineation step, and not changed the soil or landuse inputs, or the slope
bands, to recover information from the project database instead of rereading the grids. Reading
from the database is substantially faster. 
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Figure 15: Reading the land use and soil maps

25 In our case, we have chosen to make landuse and soil lookup tables from .csv files, so
when we click  Read we are first  asked to  select  the  files.   For  landuse,  navigate  to  Robit\
Robit_landuses.csv in ExampleDataset.  This has the appropriate structure for a landuse lookup
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table.  Its contents are shown in Figure 16.  The first line, commonly included, is ignored if its
first field is not numeric.  On each other line, the first field, delimited by a comma, is a value
from the landuse map.  The second field is a four-letter (unless it is HAY) SWAT landuse code,
as found in one of the tables crop or urban in the reference database.  More than one map value
may map to the same landuse code, but map values may not be repeated.

LANDUSE_ID,SWAT_CODE

1,WATR

2,AGRL

3,PAST

4,FRST

Figure 16: Robit_landuses.csv

When we select the csv file, it is imported into the project database to make a new lookup table.  
Its name is determined as follows.  First, if the file name contains landuse (as ours does) it is 
used as the basis.  Otherwise landuse_lookup is used as the basis.  Second, if the basis does not 
exist as a table name it is used, otherwise successively 0, 1, etc is appended until an unused table 
name is found and used.  In our case Robit_landuses will be the table name.  It will be selected in
the Landuse table menu and used by default next time we run the project - we only need to 
import the csv file once.

26 The csv file for soils is ExampleDataset\Robit_soils.csv and in the same fashion will 
make a lookup table Robit_soils.  It maps values from our soil map to soil names found in the 
SNAM  field of the usersoil table we made earlier in the reference database (as described in 
Appendix I, page 78).  

If you get an error saying that soil LVx (and perhaps others) are not defined it was because you 
omitted to do the actions in Appendix I.  Click OK to close the error window, Cancel to close 
the CreateHRUs window, and follow Appendix I before opening CreateHRUs from the main 
QSWAT3 window again.. You will be invited to confirm the choice of landuse and soil rasters.  
You will also see that you can select Robit_landuses and Robit_soils as the lookup tables: you 
don't need to import csv files more than once.  Make sure you check Generate FullHRUs 
shapefile again.  Then click Read.

27 After reading the grids you will notice a number of changes to the QSWAT3 display 
(Figure 17):

 A Slope bands map has been created and added. This allows you to see where the areas
of the two slope bands selected for this project are located. If no intermediate slope limits
are chosen this map is not created.

 The legends for the landuse map robelandusenew and the soil map mowr_soil90 include
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the landuse and soil categories from the lookup tables.
 A shapefile FullHRUs has been created and added. This allows users to see where in each

subbasin the potential Hydrological Response Units (HRUs) are physically located. If, for
example, we zoom in on subbasin 8, in the Legend panel select (left button) FullHRUs,
open its attribute table (right button), set the mouse to Select Feature(s) (QGIS toolbar)
and click in the map canvas on the box below the number 2, then we get a view like
Figure 18. We see that this potential HRU is composed of several parts, has the landuse
AGRL, the soil LVx, and the slope band 0-10. Its area of 154 ha is 44.8% of the subbasin.
Close the Attribute Table Editor. Generating the FullHRUs shapefile is optional, as it can
take some time. A count of the potential HRUs (51 in this example) is displayed whether
this file is created or not. 

Figure 17: After reading grids
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Figure 18: Viewing a particular HRU

28 Before you continue with HRU definition, if you look at the main QSWAT3 window you
see that a new item  Select  Report to View is available and you can choose to view just two
reports at this point, which are the Elevation and Landuse and Soil reports. The elevation report
gives information about how much land is at each elevation from the lowest to the highest, both
for the watershed as a whole and for each subbasin (Figure 19). The landuse and soil report lists
the landuse, soil and slope-band areas for each subbasin (Figure 20).
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Figure 19: Elevation report
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Figure 20: Landuse and soil report

29 At this point you have the options to split landuses, and to exempt landuses, both of
which will affect how HRUs are defined.

 Splitting landuses allows you to define more precise landuses than your landuse map
provides.  If,  say,  you  know that  in  this  basin  50% of  the  AGRL (Agricultural  land
generic) is used for corn, and the other 50% is used for teff, you could split AGRL into
50% CORN and 50% TEFF (Figure 21).  It is possible to use the original landuse (here
AGRL) as one of the sub-landuses. The percentages are integers and need to sum to 100
for each landuse you split. Split AGRL into 50% CORN and 50% TEFF as shown.

 Exempting landuses allows us to ensure that a landuse is retained in the HRU calculation
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even if it falls below the thresholds we will define later. For example, we might decide to
exempt the forest landuse FRST (Figure 22). Make this exemption.

Figure 21: Splitting a landuse

Figure 22: Exempting a landuse
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30 Once all  the  data  has  been read  in  and stored,  the  Single/Multiple  HRUs choice  is
enabled. Dominant landuse, soil, slope and Dominant HRU options provide just one HRU for
each subbasin (i.e. option of Single HRU). Dominant landuse, soil, slope chooses the landuse
with the biggest area in the subbasin, the soil with the biggest area in the subbasin, and the slope
range with the biggest area in the subbasin and uses them for the whole subbasin.  Dominant
HRU selects the largest of the potential HRUs in each subbasin and makes its landuse, soil and
slope range the ones chosen for the whole subbasin.  

The options with Filter by landuse, soil, slope; Filter by area; and Target number of HRUs
create  Multiple  HRUs.  For  the  Multiple  HRUs option,  users  can  exclude  HRUs  that  are
insignificant by considering percentage thresholds or area thresholds. The option of Filter by
land use, soil and slope, will ignore any potential HRUs for which the landuse, soil or slope is
less  than  the  selected  threshold.  The  areas  of  HRUs  that  are  ignored  will  be  redistributed
proportionately amongst those that are retained. The option of Filter by area will ignore HRUs
that are below a specified threshold amount (either percent of the subbasin, or area). Finally the
option of Target number of HRUs limits the number of HRUs to a user preferred amount (i.e.
between the lower limit of one HRU per subbasin and the upper one of retaining all potential
HRUs).   

For this exercise, use the method of Filter by land use, soil and slope and choose the Threshold
method of  Percent of subbasin. For landuse, the value of 81 as the maximum we can choose
indicates that there is a subbasin where the maximum value for a landuse is 81%. If we chose a
higher value than 81% we would be trying to ignore all the landuse categories in that subbasin.
Hence 81% is the minimum across the subbasins of the maximum landuse percentage in each
subbasin.  For this exercise, select 10% for landuse, by using the slider or by typing in the box,
and click Go. The interface then computes the min-max percentage for a soil as 52%.  Select 10
for Soil,  click  Go.  Similarly select  10 for slope.  At this  stage the user  can create HRUs by
clicking Create HRUs (Figure 23). The number of HRUs created (60) is reported at the top of
the map canvas. 
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Figure 23: Creating multiple HRUs by Filter by land use, soil and slope 

31 Create HRUs is now reported as done and the third step is enabled (Figure 24). If you
requested a Full HRUs file you will notice that an Actual HRUs file has now been added. This
contains the potential HRUs that were retained as actual HRUs (and so typically has some holes
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representing those that were not retained). This file also shows the numbering of HRUs as well
as subbasins. If you open its attribute table you will see in the last column, called  HRUGIS,
values like 000050001, which indicates that this row is for HRU 1 in subbasin 5. Input files for
this HRU (found in the TxtInOut folder) use the HRUGIS value as their base file name. HRUs
that were split, those for landuse AGRL, have two HRUGIS values, since they will have two sets
of HRU input files, one for CORN and one for TEFF.  If you look at the Reports now available
you will find that there is an HRUs report that only includes the landuses, soils and slope bands
left after HRU selection, and also gives details of the HRUs that have been formed (Figure 25).
If you wish to change the HRU thresholds then you can click the  Create HRUs button again,
check Read from previous run and click Read  to reload the map data, change the thresholds
and/or the landuses to be split or exempted, and rerun the Create HRUs step.

Figure 24: About to do step 3
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Figure 25: HRUs report

32 It is strongly recommended to save the project (via the file menu of QGIS) at this stage.

5.3 SWAT Setup and Run

33 At this point almost everything is ready to write the SWAT input files and run SWAT. The
SWAT Editor assumes that dates are written in the mm/dd/yyyy format. You may need to change
to this system on your machine,  by opening the Control Panel,  selecting  Region and setting
English (United States)  as the format. On later versions of Windows you find  Settings,  select
Time & Language, Change date and time formats, and select for Short date either M/d/yy or one
of the similar patterns that have the month/day/year pattern, differing only in the default number
of digits. Otherwise you may get messages about  invalid date.  Click  Edit Inputs and Run
SWAT. This starts the SWAT Editor (Figure 26). 
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Figure 26: Connecting the Demo project to SWAT databases

34 The local SWAT project database and reference database (referred to as a  Parameter
Geodatabase) have been selected in the first two fields.  An American soils database is selected
in the third, and the SWAT Editor folder is selected in the fourth.  These can be changed if
necessary, but should be OK already.  Click Connect to Databases to connect to the project and
references databases, and then OK to acknowledge successful connection..

35 Now the Write Input Tables form will be active. Click the option Weather Stations.

36 There are two kinds of possible weather information used by SWAT, weather generator
data and actual weather data.   Weather generator data is  data about the typical weather in a
locality,  and its  variability.   It  is  input to a weather generator tool that will  generate pseudo
random data, and this is used when actual weather data is missing, either for particular dates, or
for  particular  categories  of  weather,  such  as  solar  radiation.   (SWAT insists  on  a  weather
generator being defined for each subbasin even if there is no missing actual data.)   Weather
generator data is provided by a table of virtual  weather generator stations, each with its own
location and data.   The SWAT Editor assigns to each subbasin the weather generator station
nearest to its centroid.  For our example we have a weather generator table WGEN_Robit that
you should have imported into the reference database earlier.  (Details of how to import this data
are in Appendix I.)  Clicking the Weather Data Generator tab, and choose WGEN_Robit. 
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37 Actual weather data can be input in 5 different categories:  precipitation,  temperature,
solar radiation, relative humidity and wind speed.  In each category for which data is available,
the user supplies two kinds of files.  The first is a weather station file, containing the names and
locations of weather stations.  For each station there will be a data file containing data.  For
example, we have for rainfall a file  pcpRobStation.txt that contains one precipitation station (a
rainfall gauge) called robpcp.  This name informs the SWAT Editor that the precipitation data for
this gauge will be found (in the same folder) in a file robpcp.txt.  The file names used are chosen
by the user, with the sole proviso that the data file names must match the station names used in
the stations file.  The SWAT Editor needs only to be provided with the stations files, since it can
then find the data files.  As with weather generator station files, there may be many stations in
each file, and again each subbasin is assigned its nearest station in each category.

38 We  have  actual  data  in  all  five  categories,  stored  in  the  folder  ExampleDataset\
ClimateRobit.   The  station  files  are  pcpRobStation.txt,  tmpRobStation.txt,  solRobStation.txt,
rhumRobStation.txt,  and windRobStation.txt  for  precipitation,  temperature,  solar  radiation,
relative humidity, and wind speed respectively. For each tab for rainfall, temperature, etc. check
the option for gages rather than simulation and select the appropriate stations file. Click  OK.
The climate data files (which will be accessed by the SWAT Editor using station information as
explained  above)  are:  robpcp.txt,  robtmp.txt,  robsol.txt,  robrhum.txt,  and robwind.txt.  Click
Cancel  to close the Weather Data Definition form.

39 To write the remaining input tables and files select Write Input Tables → Write SWAT
Input Tables.  Click Select All in the list box (Figure 27) and click the Create Tables button.
There is a program for estimating the heat units needed for plant growth, using climate data, but
it is currently available only for the USA.  Since this project is outside the USA, choose the
option No. The heat units value appears in the management (*.mgt) files, and you can later edit
these values using the SWAT Editor. Also answer No to writing point source, reservoir and inlet
information. Writing the database tables can take a few minutes, especially if your simulation
covers several years, but it is fast in this case.  A form announces that the tables have been built,
where you click OK to acknowledge. If all is well the form will show that all database tables and
files have been written successfully (Figure 27).  Click Cancel.
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Figure 27: Finished writing the SWAT database tables and input files

40 Now the user can edit different SWAT databases and simulation conditions (e.g. methods
to estimate potential evapotranspiration, stream flow routing, etc). This is also the step where
users can implement different management scenarios. 

41 To run SWAT click SWAT Simulation → Run SWAT. Since we provided actual climate
data (for 24 years from the start of 1900), the SWAT Editor has calculated the minimum and
maximum dates that we can use.  Set the time periods to run SWAT  to 01/01/1990 to 12/31/2000
(remember to use the m/d/y format!), chose Monthly time step, and NYSKIP (initial number of
years to skip of 3), check the Print Water Quality Output option, and leave the Output File
Variables set to All. Select a release version of SWAT.exe, 64-bit if you have a 64-bit machine,
else 32-bit. Finally click Setup SWAT Run (Figure 28). This step activates Run SWAT. 
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Figure 28: Setting up SWAT Run

42 Click Run SWAT to launch the SWAT executable in a command window (Figure 29).
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Figure 29:  Running SWAT

43 If the run is successful the command window will close and a message box will say that
SWAT was run successfully. Click OK.

44 If the run is not successful the command window will stay open with a message telling
you to Hit Enter to exit. The release versions of the SWAT executable run faster than the debug
versions, but don't provide information on errors, so if you have an error hit enter to close the
command window and run SWAT again but with a debug version of  SWAT.exe selected. The
error message may suggest which SWAT input file needs to be checked, or you may be able to
get more information from examining the SWAT source code, but probably you will need to
report  the  problem  to  the  SWAT  team.  Go  to  the  SWAT  support  page
http://swat.tamu.edu/support/ for advice. Click Cancel  to close the SWAT simulation window.

45 If you want to use QSWAT3 visualisation you need to use  Read SWAT Output in the
SWAT Simulation  menu.  Select  output.rch,  output.sub,  output.hru,  output.sed,  and  (if  you
checked  Print Water Quality Output  in the  Run SWAT form) output.wql, and click  Import
Files to Database.

40

http://swat.tamu.edu/support/


46 The  SWAT simulations  can  be  saved using  the  Save Simulation button  under  Save
SWAT  Simulation.  This  copies  C:\QSWAT_Projects\Robit\Demo\Scenarios\Default to  C:\
QSWAT_Projects\Robit\Demo\Scenarios\Sim1 if  the  user  chooses  to  save  as  Sim1.   If  Sim1
already exists it will ask the user to confirm it should be overwritten. Click Cancel  to close the
SWAT Output form.

47 Set Default  Simulation option  under  SWAT Simulation tab helps  to  restore the model
parameters and its output back to a preferred previous SWAT simulation (i.e. not necessarily
only to the default simulation). 

48 Manual Calibration helper  option under SWAT Simulation  is  used to calibrate  SWAT
parameters  manually.  It  can  also  be  used  to  implement  calibrated  model  parameters  for
SWAT  simulation  when  automatic  model  calibration  is  done  outside  the  QSWAT3
environment (e.g. using SWAT-CUP). 

49 Click Exit  to close the SWAT Editor.

5.4 Output Visualisation with QSWAT3

Once  SWAT  has  been  run  and  the  output  imported,  so  that  there  is  an  output  database
SWATOutput.mdb in  the  Scenarios\Default\TablesOut folder  of  the  project,  then  a  button
Visualise becomes available in the main QSWAT3 form (Figure 30). Visualisation allows outputs
from SWAT to be visualised graphically by subbasin, reach, or HRU.
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Figure 30: Main QSWAT3 form showing Visualise button

5.4.1. Preparing to visualise

In order to visualise results you have first, of course, to (successfully) run SWAT. Then you have
to  save  your  results  in  the  output  database.  To  do  this,  in  the  SWAT  Editor,  use  SWAT
Simulation → Read SWAT Output to bring up the SWAT Output form. Then check the boxes
for the outputs you want to save in the database. QSWAT3 can display results from output.rch,
output.sub,  output.hru,  output.sed,  and  output.wql  (which  only  has  data  if  the  Print  Water
Quality Output was checked in the SWAT Editor  Run SWAT form). Then click the  Import
Files to Database button to create (or update) the database. It is a good idea to use the  Save
Simulation button to save the simulation, having provided a suitable name. Then if you change
anything and run SWAT again, the results from the saved run will still be available. Saving the
previous simulation also saves copies of the watershed, streams and actual HRUs shapefiles,
which  are  needed  for  visualisation,  and  which  may  be  changed  if  you  rerun  watershed
delineation or HRU creation. Click Cancel to exit from the SWAT Output form, and Exit from
the SWAT Editor.

5.4.2. Running visualise

Click Visualise on the main QSWAT3 form to bring up the Visualise Results form (Figure 31).
Here  the  Choose  scenario pull-down  menu  shows  the  simulations,  or  scenarios,  that  are
available: the current Default one, and in this example another called Sim1 that has been saved.
Select the one that you wish to display. Then use the Choose SWAT output table to see what
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tables are available: you will see all or some of hru, rch, sed, sub, and wql (the list depends on
the output files you imported into the SWATOutput database). Select sub.

5.4.3. Visualisation period

The start and finish dates shown are initially the start and finish dates of output from the Default
scenario. Note that the initial year is 1993 since we simulated from 1990 but set NYSKIP to 3.
You may choose dates within these if you wish, to shorten the period being visualised.  If other
scenarios are selected, the dates will be changed if necessary to ensure there is data available for
the whole period.

5.4.4. Static visualisation

There are three possibilities shown by the tabs for Static data, Animation and Plot. For static
data a single summary value is calculated for each subbasin, reach, or HRU and displayed as a
map. For animation there is an animated display of the value in each subbasin, reach, or HRU at
each time step  in  the  animation.  Plot  supports  the  creation  and display  of  plots  of  selected
variables.  This  section  deals  with  static  data;  animation  and  plotting  are  described  in  the
following sections. Make sure the Static data tab is selected.

Static  results  are  created  by  generating  a  shapefile,  and  by  default  this  will  be  called
<table>results.shp (e.g.  subresults.shp) and  stored  in  the TablesOut folder  of  the  current
scenario. You can leave this default, or change the file name and location as you wish.  You may
notice files called hrus.shp, rivs.shp, and subs.shp in this folder. Do not choose any of these as
your file name: they are copies of the actual HRUs, stream reaches and watershed shapefiles
generated by QSWAT3, copied into this folder and used as a basis for the results shapefile (and
for animation). This is done because these shapefiles may be changed by subsequent runs of
QSWAT3 and not have the same HRUs, stream reaches or subbasins as this run had. 

If you have saved at least one scenario you will see a box Compare scenarios in the Visualise
results form  (Figure  31).   This  allows  the  visualisation  of  comparative  results  from  two
scenarios, and is discussed later.

The pull-down menu in  Choose variables contains all the output variables from your chosen
table.  You can select these one at a time and use the Add button to add them to the box below, or
simply click All to get all of them. You can adjust your selection by selecting and using Del to
delete ones, or using Clear to delete all of them. Data from all the variables you place in the box
will be placed in the results file. You then need to select one of them to be displayed.   It is a
good idea in general to select All as this allows you to display different variables without having
to change the results file. 
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Figure 31: Visualise results form

For each variable, for each subbasin, the output data has a value for each day, month, or year of
your simulation (according to what printout frequency you chose for the SWAT run). To display
the results graphically we need to produce a single value for each variable for each subbasin, and
for this we choose a Summary. Summaries available are:
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 Totals: the summary is the total of the values for the variable for the subbasin, reach, or
HRU.

 Daily means: the summary is the daily mean of the total, the total divided by the number
of days in the simulation.

 Monthly means: the summary is the monthly mean of the total, the total divided by the
number of months in the simulation. The number of months may be fractional

 Annual means: the summary is the annual mean of the total, the total divided by the
number of years in the simulation. The number of years may be fractional.

 Maxima: the summary is the maximum value for the variable for the subbasin, reach, or
HRU.

 Minima: the summary is the minimum value for the variable for the subbasin, reach, or
HRU.

For variables which are effectively means, such as rates of flow, only some of the summaries
make  physical  sense,  namely  the  mean  for  the  chosen  printout  frequency,  maximum,  and
minimum. Users should therefore exercise caution in choosing summaries for such variables.
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Figure 32: Displaying results

When you have loaded the variables you want included into the variables box, selected the one to
display (SURQmm for this example), and chosen the summary (annual means), click the Create
button.  You may be asked to confirm if  you are overwriting an existing shapefile.  Then the
results file will be displayed as shown in  Figure 32. The legend shows that we are displaying
SURQmm annual mean values from the Default simulation.

The results layer is given a default coloring using 5 intervals chosen by the Jenks natural breaks
algorithm to cover the range of summary values for the variable. You can change the coloring
scheme if you wish (right click on the layer entry in the Layers panel, select Properties and then
select the Style tab).

To display a different variable from the list, select it with the mouse and click Create.  To change
the summary, select the new one from the pull-down menu and click Create.
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Comparing scenarios
If you have two or more scenarios there is a short cut method for comparing their outputs. You 
will see the Compare scenarios box is visible.  Click the Compare button to open a small form 
that allows you to choose scenarios 1 and 2.  You should choose 1 as the older scenario.  For 
example, if you created a first scenario, saved it as Sim1 and have now created a new one, 
currently the default and not yet saved separately, you should choose Sim1 as Scenario 1 and 
Default as Scenario 2.  Click OK and the text above the Compare button changes to Compare 
Sim1 and Default.  Now make sure you have selected an output table, selected a variable, and 
chosen a summary method, just as you do in a static visualisation.  Then when you click Create, 
four files will be added to the Results section of the legend and displayed in the main canvas:

• a results file for scenario1
• a results file for scenario 2
• a comparison results file, where the values are for scenario 2 minus scenario 1
• a comparison results file where the values are for scenario 2 minus scenario1 expressed as a 

percentage of the scenario 1 value

You should only do this if there is no change in delineation between scenarios 1 and 2, or the 
results are likely to be nonsense as the subbasin numbers are likely to be different in the two 
scenarios.  And if you are choosing to compare HRUs then there should also be no change in 
HRU creation between the scenarios.

Calling the scenarios S1 and S2, the four results shapefiles are created in a directory placed 
within the Default\TablesOut directory, called S1_S2, and named

• S1-<table>-<variable>-results.shp (eg Sim1-wql-ORGN_OUT-results.shp)

• S2-<table>-<variable>-results.shp (eg Default-wql-ORGN_OUT-results.shp)

• <table>-<variable>-diff.shp (eg wql-ORGN_OUT-diff.shp)

• <table>-<variable>-%change.shp (eg wql-ORGN_OUT-%change.shp)

and for all of them the values displayed will be in a field with the name of the variable (eg 
ORGN_OUT).

To turn off  the generation of scenario comparison results files, click Compare again and then 
Cancel in the Compare Scenarios form.  The text above the Compare button reverts to 
Compare X and Y, indicating that the automatic comparison mode is off.
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5.4.5 Printing
You may want to create a printout of your SWAT results, and QSWAT3 makes use of the QGIS
Print Composer to help you do this.  There are a number of predefined templates to create a
composition of 1, 2, 3, 4 or 6 results maps laid out in either landscape or portrait mode.

The templates  are  not  expected  to  provide  final  compositions.   They are  rather  intended to
provide a  basic  composition  for  you to  edit  using  the  Print  Composer.   Such editing might
include  adjusting  the  size  and  position  of  the  map  boxes,  adjusting  the  scale  of  the  maps,
changing  the  text  in  the  text  boxes,  adding  new  text  boxes  or  images,  removing  existing
elements.

As well as containing 1 to 6 maps, each with its legend, each of the templates provides

 a page title, initially containing "SWAT results: <project_name>"
 a North arrow
 a scale bar
 a text box containing "Author/Company"
 a date text box containing "Created on: <date>" where the date is in yyyy-mm-dd format

Figure  33 shows the  result  of  creating  a  3  map portrait  print  composition  and immediately
exporting it.  In practice one would at the very least replace 'Company/Author' with something
appropriate (or remove it) and perhaps lower the legends for the first and third maps to avoid the
clash of their texts with the corresponding maps.

To create this composition we

 created the SURQmm map as described earlier
 switched to the Sim1 scenario, the sub table, and created the SWmm annual means map
 switched to the rch table and made the SEDCONCmg_kg annual means map.  As it is

based on the rch table it uses streams as the basis for the display.  Line widths correspond
to stream widths, and colours to variable values.  To show this map clearly in the canvas
you need to remove the visibility of other results maps, but (as explained below) this will
not affect the print composition.
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 selected Portrait and 3 as the Number of maps in the Print group in the visualisation 
form's static tab, and clicked Print.
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Figure 33: Print composition
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It is important to note that if two maps use the same scenario and table, they would by default
use the same results file and the second would replace the first as a results layer in the Layers
panel.  To avoid this, if you want both in the print composition, you have to change the name of
the results shapefile for the second one.  This was not necessary here since for the second map
we used the Sim1 scenario.

The rules use for creating print compositions of n maps are as follows:

 The first n maps in the Results group in the layers panel will be used.  They are taken one
at a time, whether or not they are currently marked as visible.  They are displayed in the
order in which they occur in the Results group, stepping from top left to bottom right, and
across before down, in the composition.

 Layers  in  the  Watershed  group  are  included  in  the  background  if  they  are  currently
marked as visible.  It is normal to have the Watershed layer visible, so you can see the
subbasin boundaries, and common to have the Reaches layer also visible.  (Results layers
have their  transparency by default  set  at  35% to enable these watershed layers to be
visible as well.)

 The  print  composer  is  created  with  the  map  layers  locked  (otherwise  they  would
automatically change to whatever the map canvas currently contains) but with all the
composition items unlocked, so they can be moved, resized, have their text changed, etc.)

 The scale bar is attached to the first (top left) map.  If you change that map's scale the
scale bar will change automatically, but will not reflect the scales of the others unless you
change them similarly. 

To avoid the maps in the print composition being smaller than necessary, before you click Print,
select the FullHRUs entry in the Layers panel, (doesn't matter if it is visible or not) and click the
'Zoom to layer' button at the top.  Reshape your map canvas to make your watershed fill it as
much as possible.  If you don't have a FullHRUs shapefile, an alternative technique is to set the
Scale using the drop down menu to a value fairly close to the current one, such as 1:50,000.
Then adjust the window size and shape, aiming to make the boundary of the map canvas as close
as possible to your watershed boundary.  Annoyingly, this tends to change the scale, but because
you chose one in the menu it is easy to reset, and you should with a few adjustments achieve a
good fit.

This document cannot describe all of the features of the QGIS Print Composer.  There are 
documents (e.g. https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/index.html) and 
tutorials (e.g. https://www.qgistutorials.com/en/docs/3/making_a_map.html) on the web.

But here are a few hints for some common tasks (all done in the print composer):
 The first lines of legends are often longer than you want.  To change their font, select the

legend in the main window, then open Fonts and Text Formatting (on the right), and the
relevant item is 'Subgroup font'.  To edit the text, select it in the panel under  Legend
Items,  then use the button for text editing (pencil and paper symbol).  To reduce the

51

https://www.qgistutorials.com/en/docs/3/making_a_map.html
https://docs.qgis.org/3.10/en/docs/user_manual/print_composer/index.html


vertical  spacing between legend items open  Spacing and change  Subgroup space (to
1mm perhaps)

 To change the size of maps, select the map in the main window and then edit the Scale
entry under Main properties.  The scale is the ratio of actual distances to map distances,
so you reduce it to make the map larger.  Use the same number for all the maps and the
scale bar will stay correct (it changes automatically with the first map).

 It is possible to use HTML in labels.  The tutorial mentioned above has an example.
 Use  the  Items panel  (top  right)  to  lock  what  you  have  fixed,  to  avoid  accidentally

changing it again.

5.4.5.1  Printing other maps

It may be that you would like to include in a print composition other maps, such as the landuses
or soils.  All you need to do is include such a layer in the Results group.

But the map you have may well extend outside the watershed.  We illustrate how to deal with this
by adding a landuse map to our print composition.

The first task is to clip the landuse map to the watershed boundary.  First we will need to know
the nodata value for this map - it is always a good idea when using QGIS tools for transforming
maps to know and use the nodata value.  Right click on the Landuses entry in the layers panel,
select Properties, and under Bands in the Information tab you will see the nodata value for Band
1 is 255.  (This is unusual - it is usually negative - but 255 is often used for maps with 8 bit
unsigned Byte data, as this is.)

Select (left click) another layer in the Results group (which will place the new map above that
layer), Then use Raster → Extraction → Clip Raster by Mask Layer  to bring up the Clip form.
Find the  Landuses layer in the drop-down menu for the  Input layer, and select the  Watershed
(subs1) layer  as the Mask layer, and assign a nodata value by typing 255 in the box.  The only
other setting you need to change from the defaults is the Clipped (mask) setting.  Select Save to
file using the button on the right, browse to (for example) the Source\crop  folder and use a name
such as  landclip for the  Output  file.  Make sure  Open output file after running algorithm is
checked (Figure 34).  Click OK.

It is not unknown for clipping with the watershed shapefile to fail with a message that there is a
fault in the shapefile.  An alternative is to use the Saga raster calculator, which seems to be
reliable for this purpose.  First load the raster Source\srtm_30mw.tif,  which is the raster version
of the subbasins map.  Then use Processing → Toolbox to see the available tools, find SAGA→
Raster Calculus → Raster calculator.  In the raster calculator form choose the Landuses layer as
the main input layer, and use the Additional layers  button to open the Multiple selection form.
Check srtm_30mw and click OK.  Enter the formula gt(b, (0-1)) * a, click the Calculated button,
choose Save to file,  and browse to, say, Source\crop and use landclip as the file name.  Saga uses
a special format with a filename suffix of .sdat, but this is of no consequence.  Click Save, and
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then Run the calculator. (The idea behind the formula is as follows: a is the landuse file we want
to clip.   b  is  the subbasins raster  b which has valid values from 0 up within the watershed
boundary and nodata outside it.  The gt expression will return 1, so that a  values are preserved,
where  b   is valid,  Outside the watershed boundary,  b   gives nodata, and the calculator there
gives the result a nodata.)

The result (from clipping or from using the raster calculator) will not be very satisfactory.  The
name will be landclip.  Right click on the layer, and use Rename to change it to, for example,
Landuse.

The legend will only include numeric map values and the default coloring will be black and
white or grey scale.  You can fix this by copying the style of the original Landuses layer.  Right
click on that layer, select Styles -> Copy Style, right click on the Landuse layer and select Paste
Style. 

The colors used for the original landuses map were chosen randomly, and you may want to
change  them.   Right  click  on  the  new  Landuse layer  and  select  Properties  and  then  the
Symbology  tab. Double right click on entries in the color map to make a color selection tool
available. Choose another color, and click  Apply  to see the result in the map canvas.  You may
also wish to set the layer's transparency so that the subbasin boundaries and streams are visible:
use the  Transparency tab in the  Properties form, and set  Global Opacity to, say, 80%.  Click
Apply to see the result.  Click OK  to finish.

If necessary, drag the Landuse layer to the position you want in the Results group

Figure 35 shows a 4-map landscape print composition with the landuse map.

It is finally worth mentioning that it can be that parts of results shapefiles can lose all color,
becoming white and transparent, when they are at the upper or lower limit of the range of values.
This sometimes happens when the project is restarted.  If this happens you can fix it by using
Properties and then the Style tab to show the coloring scheme of the affected layer, click Classify
to recalculate the bands, and then click Apply and OK.
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Figure 34: Clipping landuse map
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Figure 35: Print composition with landuse map

5.4.6 Animation

To animate, select the Animation tab (Figure 36).

There are two modes of animation: using the map canvas and using a print composer.  Map
canvas  animation  shows  the  animation  for  one  output  variable  in  the  map  canvas.   Print
composer animation can show (by creating a  video) the animation of 1,  2,  3,  4 or 6 output
variables in synchrony.

5.4.6.1 Map canvas animation

Make sure you have the scenario and output table you want, and that the dates are for the period 
you want to animate.  You probably do not want, for example, to animate at a monthly time step 
for more than a year or two.
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Initially, select New in the Set up animation group.  The Variable pull-down menu contains all
the variables from the chosen output table: select one of these. A new animation layer is created
in the map canvas, showing the initial values of this variable in the simulation (Figure 37). Here
we are animating the PETmm variable from the sub table in the Sim1 simulation. Note that the
range  of  possible  values  runs  from 98.8  to  181.7  (the  minimum  and  maximum values  for
PETmm  for  the  whole  simulation  period).  You  can  view  the  actual  initial  values  for  each
subbasin  by  examining  the  attribute  table  (right  click  on  the  Sim1  PETmm entry  in  the
Animations group in the Layers panel and Open Attribute Table).

There are controls to run, pause and rewind the simulation: it steps through daily, monthly or
annual time steps according to the reporting period chosen for the simulation. The speed of the
animation can be adjusted using the Speed spinbox. You can also investigate the changing values
manually, by dragging the slider, or by pressing the left and right arrows on your keyboard. The
date (day, month, or year) of each step appears above the slider.

The animation is achieved by creating a shapefile in the  Animation folder of the scenario. At
each time step the values of the variable are updated and the file redisplayed. Hence this file is
being continuously changed. It is regarded as a temporary file and so is not preserved.  If you
wish to save a view of the animation at a particular moment you can pause the animation and
make a copy of this file (remembering to copy the .dbf, .prj, and .shx files as well as the .shp
file).  Hover the mouse over the entry in the Layers  panel to see its name.

It is also possible to make a video of the animation.  To do this, at the position when you want to
start the recording, click the Start recording button.  This will turn red, to show recording is in
progress.  Then run, or resume running, the application.  Wait until this finishes, or pause it if
you  wish,  and  click  Stop  recording.   This  will  create  an  animated  gif,  called
<variable>Video.gif (in this case PETmmVideo.gif ) in the TablesOut folder of the scenario.  You
can watch the video by clicking the Play recording button.

If you get a memory error, with a message suggesting you try GIMP, see the instructions on page
63.
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Figure 36: Map canvas animation

The animated gif is made from a collection of .png images created in a folder Png in the default
scenario's  TablesOut folder.  The video is created, and these image files deleted, by stopping
recording, so if you want to do anything with these files you need to do so after the animation
(for example when it reaches the end or when you pause it) but before you click Stop recording.
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The speed of the video is determined by the Speed spinbox setting when the video is created: it
will not reflect any changes in speed made while it was recording.  It may play back faster than it
was recorded, so you may need to recreate it with an adjusted speed setting if it runs too fast.

Figure 37: Start of animation

When you click the  Play button your computer's default application for displaying gif files is
used  

Note that the animation video file name starts with the name of the variable being animated.  So
you may safely make a number of animations of different variables.  But if, for example, you
wanted to animate the same variable over different time periods you would need to copy or
rename the first animation file before making the second.

As with static visualisation, it is possible to change the coloring scheme used (the color ramp
and/or the number of classes): right click on the legend entry, select Properties and then select
Style.
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5.4.6.2 Print composer animation

Print composer animation adds two possibilities to map canvas animation:
 The animation is based on the print composer, and so adds more possibilities like extra

labels, scale bar, north arrow, etc.
 It allows the synchronous animation of 1, 2, 3, 4, or 6 variables.

It consequently needs a little more setting up.  On the other hand, there is no equivalent to the
slider or left/right keyboard arrows for running the animation after its creation.

In the previous section we used the New choice in the Set up animation box.  If we keep the New
setting and select another variable (possibly after changing the scenario and/or table) we will get
another animation layer.  Figure 38 shows the situation after we changed the table to  rch and
selected SEDCONCmg_kg as the variable.  If we had changed the choice to  Current before
selecting the variable, the SEDCONCmg_kg layer would have replaced the PETmm one.  The
current animation layer is the currently selected (or only) layer in the Animations group.  (If there
is no such current layer it is as if New were selected.)

Figure 38: Second animation layer added
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We could now run the animation in the map canvas, but it will not be very satisfactory as one
layer  lies  over  the  other.   It  would  be  even  less  satisfactory  if  both  layers  were  based  on
subbasins, or on streams, or if there were more layers.  So instead of choosing Map canvas as
the Animation mode, we select  Print composer (Figure 39).

This brings up a choice between Landscape and Portrait layouts, and selects 2 as the number of
maps, since we currently have two animation layers.  We can add more such layers if we wish,
and increase this number, or reduce it to 1.  If the count is set to n, then the top n layers in the
Animations group will be used (regardless of their current visibility).  In addition, as with static
print compositions, visible layers in the Watershed group are included.
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Figure 39: Setting up a print composer animation

Change the layout to Portrait, move the slider by hand to near the end of the period, say to June
2000 (to reduce the number of images we will  be creating) and click  Start recording.   An
information form is shown explaining that the layout composer is about the start and that you can
modify  it  as  you  wish,  but  then  must  save  it  as  a  template  file,  which  must  be  called
AnimateTemplate.qpt and placed in the TablesOut folder of the Default scenario.  Click OK.
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The layout composer appears (Figure 40).

Figure 40: Animation print composer

You can now make what changes you would like: changing the positions or scales of the maps
(keep the same scale for both!), removing or adding labels, changing the 'Company/Author' text,
and so on.  When you are ready, use the Layout → Save as Template menu item to save as C:\
QSWAT_Projects\Robit\Demo\Scenarios\Default\TablesOut\AnimateTemplate.qpt as  previously
instructed.  You will have to confirm saving as the file already exists - it was used to set up the
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composition you have just edited.  Close the print composer.  (If you made no changes you can
close the composer without saving the template.)

The form shows that we are recording, since the recording button is red, so we run the animation
by clicking the run button (the grey right-pointing arrow).  When it reaches the end, click Stop
recording.   Click Play to see the recording.  The recording is called Videon.gif  where n is an
integer used to generate a new file name, and is stored in the  TablesOut folder of the  Default
scenario.  An information message gives the file name.

5.4.6.3 Gif creation failure
 
Creating the animated gif from the .png files seems to consume a lot of memory and can fail.  If 
this happens, you will get an error message reminding you where the .png files are (in C:\
QSWAT_Projects\Robit\Demo\Scenarios\Default\TablesOut\Animation\Png) and suggesting you 
use GIMP.  You may of course use any program (or internet service) you wish, but GIMP  is a 
well respected, open source and free program that can perform a wide range of image 
manipulations, and animated gif creation is very easy with it.  You can download it from 
https://www.gimp.org/downloads/.

To create the animated gif, start GIMP.  Use  File → Open as Layers and navigate to the  Png
folder, where you will see files still00001.png, still00002.png, etc.  Click on the first, and Shift-
click on the last so all are selected, and click Open.  The files are loaded as layers into a single
image.  Make sure the layer you can see is the last one (see the date at upper or lower left).  If it
is the first, reverse the order: use Layer → Stack → Reverse Layer Order to do this.  Now we
just save as an animated gif.  Use File → Export As to open the Export Image form.  Select a
suitable folder and file name - make sure it ends in .gif - and click Save.  A new Export Image as
GIF form starts.  Set the choices as shown in Figure 41.  The points to note are

 Check As animation
 Uncheck Loop forever
 Set the delay to something bigger than the default 100 milliseconds: We have set it to

2000 (i.e. 2 seconds).
Click Export.  Wait for it to finish: the current form closes and a new one appears.

When you use File → Quit to quit from GIMP, you may get a message that there are unsaved 
changes.  This seems to be an error: Discard Changes can be clicked.  You can then use an image
display tool or a web browser to view the animation.
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Figure 41: Creating animated gif using GIMP

5.4.7. Plotting

Plotting allows the rapid display of output  data  as line graphs or bar charts,  plotting values
against time, as load/flow duration curves, as scatter plots, or as box plots. It is intended in
particular to facilitate comparisons of outputs from different scenarios, or different subbasins,
reaches, or HRUs, or between simulated and observed values.  

Plotting is done in two stages, data collection and display. After collection, just before display,
data is saved in a comma-separated value (.csv) file. This file can be loaded into tools like Excel
to  support  more  extensive  analysis  than  provided  by  the  plotting  tool  SWATGraph  that  is
supplied with QSWAT3.

5.4.7.1. Collecting plot data

As with other visualisation options, start by selecting a scenario and SWAT output table. Then
reduce the period if you wish. Next you can select an observed data file if you have one (Figure
42). The structure of observed data files is described later.  Observed data is regarded as having
the same units as the immediately preceding plot: it is not allowed to place it first in the plot
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table.

As many plots as you like may be added to the table (but only the first two will be used if you
make a scatter plot). Then you need to choose the Plot type from the pull down menu.  You start
filling the table by clicking Add plot. This adds a row to the table, and already shows the chosen
scenario and table. The Sub (subbasin) field is empty and so is the  Variable. This first row is
also the currently selected row, and this is important. Whenever we change the scenario, output
table, subbasin, HRU or variable settings through their pull-down menus we will immediately
change values in the currently selected row.  When you have more than one row you can select a
row by clicking in it.

Whether the HRU setting is available or is set to '-' depends on the table we are using. If it is hru
(and we chose a multiple HRU option for the scenario) then we can choose an HRU from the
current subbasin. Otherwise HRU is not used and is set to '-'.

Suppose we want to compare the main outlet flows from two scenarios.  The immediate question
is what is the reach or stream number.  There are various ways to do this, and for subbasins it is
particularly easy as the number is provided as a label on each subbasin.  QSWAT3 also provides
map tips.  If you  Show Map Tips (button like a yellow speech bubble in the top tool bar of
QGIS)  select the  Watershed,  Reaches or  Actual HRUs layer in the  Layers panel, and then
hover the mouse over the map canvas, the subbasin, reach or HRU number at the mouse point
will  be displayed.   For HRUs you will  see a string like  000010002 or  000010002, 3 which
indicates in the first case subbasin 1 HRU 2 and in the second case subbasin 1 HRUs 2 and 3: the
result of splitting an HRU into 2 landuses.  To add such an HRU to a plot you would use 1 as the
subbasin number and 2 (in the first case) as the HRU number, or choose between 2 and 3 for the
HRU number in the second case.  The other method is to select a layer in the layers panel, right
click on it to open its attribute table, select a feature using the Select Features button, and the
selected feature's attributes will be highlighted.  You may have to scroll the table to find it.

Having found the main outlet reach's number, probably 1 for this example, you normally use it
for  both  scenarios  because  they  shared  their  maps.   This  may  not  always  be  the  case,  and
comparing outlet  flows is  one case where it  is  reasonable to  compare models with different
delineations but with the same outlet point.  If scenario  Sim1, say, has a different  delineation,
you can find its maps for subbasins, reaches and HRUs in the folder Sim1/TablesOut as subs.shp,
rives.shp and hrus.shp respectively.  You can find the numbers you need using the attribute table
method, and the fields you want are Subbasin, Subbasin (note that reaches have the same number
as their subbasin) and HRUGIS respectively.  
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In our case for both scenarios the main outlet subbasin is number 1. Then rch is the appropriate
table, and we select this and select 1 as the Subbasin. Finally we select FLOW_OUTcms as the
Variable. Now we want to add a second row to the table for the other scenario. A convenient
way to do this is the Copy plot button. This copies the current row to a new row, and makes it
current. Then all we have to do is choose a new scenario and the second row will be (almost)
what we want. The subbasin number is cleared in the new row, to remind us that in a different
scenario subbasin numbers might be different. We select the appropriate number, in this case 1
again.

It is also possible to move the current row up or down: this just affects the ordering of the plots
in the output.  In our case the Sim1 scenario is just a copy of the Default one, so there is no point
in plotting one against the other.  Use Delete plot to remove one of the plot rows.

To add observed data we select an observed data file.  Add the data file observedFlow.csv from
ExampleDataset and use the button Add observed. observed is used as the scenario name, '-' is
used for Table, Sub, and HRU, and we can select a variable name from the file.  In this case there
is only one, Flow.

Set the Plot type to Graph/bar chart.  (We describe other plot types later.) Then click Plot. This
invites us first to choose a  .csv file to save the data. We can if we wish later import this into, for
example, Excel if we wish to do further manipulations or use Excel’s graphing tool.  Provide a name,
eg  flow, and click Save.

You will get an error  Missing data for date 1998/1 for plot 2 (assuming the observed plot is
second in your table).  The reason is that this file only contains data from the start of 1993 to the
end of 1997.  Change the year of Finish date to 1997 and click Plot again.  You can use the same
csv file (especially as the old one is useless), and confirm that you want to overwrite the old one.
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Figure 42: Plot screen

Once the data is written to the  .csv file, SWATGraph is automatically started to display the data
graphically: see Figure 43. The data has been displayed as line graphs. We can change the display to
bar chart using the Chart Type pull-down box and clicking Update Graph. 
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Figure 43: SWATGraph

Other SWATGraph options include importing another (similarly created)  .csv file, using  New
File to Plot, and using the buttons immediately below the graph.  These include zooming and
panning the graph, saving the graph in a variety of image formats (the rightmost button) and a
number of editing options (rightmost button  but one).  You can add a title,  change axis labels,
change the colours of the plots, and (for line graphs only) change the vertical axis from linear to
log scale, which is useful when there is a wide variation in values.  Editing the graph can disrupt
the date markers on the horizontal axis: click the Update button to restore them.

The data from the  .csv file is also displayed. The column headings, also shown in the graph
legend,  take  the  form  Scenario-Table-Number-Variable,  where  Number is  the  subbasin
number if the table is reach or subbasin, and the hru number if the table is hru. For an observed
plot the form is observed-Variable.

At the bottom of the screen some statistics are displayed. These are correlation coefficients and
Nash coefficients for each pair of plots. Some of these may be meaningless, of course, if for
example you choose to plot four things that are really two pairs, but it is quicker as well as
simpler to calculate them all than it is to ask the users what they want.
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SWATGraph  may  also  be  run  as  a  stand-alone  tool.   First  check  that  the  setting  of
OSGEO4W_ROOT in the second line of C:\SWAT\SWATEditor\runSWATGraph.bat matches the
path to your installation of QGIS.  If your QGIS is not a long-term version you will also need to
change the QGISNAME setting in the next line to qgis instead of qgis-ltr.  Then double click on
this file to start it, or use its path as the command in a command shell.  In the latter case you can
optionally add the path to a .csv file to plot the csv file automatically at the start.

Plot types

A number of plot types are supported:

• Line graphs/bar charts
• Flow/load duration curves
• Scatter plots 
• Box plots

The type can be selected from the Visualise Results form, as we saw earlier, before starting 
SWATGraph, or from the Plot type pull-down menu in the SWATGraph form.

The first of these was covered above.
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Figure 44 shows the result of adding the variable SEDCONCmg_kg for subbasin 1 from the rch
table and using plot type Flow/load duration curve.  This illustrates another feature of the line
graph and duration curve plots that when the variables are different extra axes are added on the
right, showing the appropriate range of values for each additional variable.  The colour of the
axes matches the colour of the (first) graph for that variable.  There is no need for an axis for the
observed data because it is assumed to match the variable of its immediately preceding graph,
that for flow out.
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Changing the SWATGraph plot type to Box plot gives the result shown in Figure 45.  There is a
box plot for each data set, and those sharing the same variable are grouped together.  Numerical
values for each box plot (minimum, maximum, median, lower and upper quartiles) are included
in the bottom panel.

To illustrate scatter plots we Close SWATGraph, delete the observed data line in the plot table, so
we are left with the FLOW_OUT and SEDCONC lines, and select  Scatter plot  as the type.
Plotting this is shown in Figure 46.  The line of best fit is drawn as well as the scatter points.
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5.4.7.2. How compatible do different scenarios need to be?

Obviously,  they need to use the same time interval (monthly, daily or yearly). The period is
automatically adjusted to include all the scenarios involved (but see below for observed data).

You  also  need  to  be  reasonably  confident  that  the  things  you  want  to  compare  are  indeed
comparable, so if you are comparing hrus, for example, they should be the same hru in each
scenario. But if you are comparing the main outlet reach in each scenario, which gives figures for
the whole watershed, it doesn’t matter how the subbasins and hrus in each were selected, or how
the subbasins are numbered, as long as you select the main outlet subbasin number for each.
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5.4.7.3. Including observed data

To include observed data you need to prepare a .csv file, i.e. a text file where each line consists of
the same number of items (one or more), separated by commas. 

The first line must be comma-separated text strings, which will be used as the variables. If the
first string is DATE, or Date, or indeed these four letters in any case, it and the data in the first
column are ignored. The dates are assumed to be the same as in the SWAT output plots; they are
not checked.

The data on lines two to the end (apart from ignored dates) should normally be numeric.  If you
do not have complete observed data, you should include the relevant dates in the file, since dates
are assumed to be sequential, but leave the data fields empty.  You still need to insert the same
number of commas as in other lines.  In fact you can put anything in the fields, like "missing" if
you wish: any field that SWATGraph cannot parse as a number will be taken to be missing data.

Dates  on  which  some data  is  missing  are  excluded  from the  Pearson  and  Nash  coefficient
calculations (and the number of values used in the calculation is reported).  Missing data will
appear as breaks in the relevant line graph, and as missing bars (indistinguishable from zero
values, of course) in bar charts.  You can check where data is missing from the data table, where
you will see blank fields, or the text like "missing" that was used in the .csv file.

Table, Subbasin and HRU boxes in an observed plot row will be unavailable, but you need to
choose a Variable. The choices in the Variable pull-down box will be the variables (apart from
date) in the first line of the .csv file.

5.5 SWAT Output Visualization with SWAT Error Checker
SWAT-Check is a tool that is used to summarize results from SWAT simulations. It can also
provide warnings that can help to improve the modeling skills in SWAT. Currently, the program
is integrated with the SWAT model and it can be found under the SWAT Simulations tab, and
under  Read  SWAT Output drop-down  list.  It  can  also  be  installed  separately.  It  can  be
downloaded from the SWAT website: http://swat.tamu.edu/software/swat-check/.  
 
SWAT-Check evaluates different processes in the landscape. The following section describes the
purposes of some of the tabs in the SWAT-Check program. Each tab has also brief note on the
subject it is dealing with.  
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Button to choose a particular simulation

1 SWAT-Check evaluation can be executed by locating the TxtInOut folder of a particular sim-
ulation (Figure 47). Clicking Run SWATCheck button from the SWAT Output form directs
to the TxtInOut folder in the Default simulation folder (the Default simulation always saves
results from the most recent SWAT run). However, different simulations can be accessed by
clicking the folder button in the right of the Project Location (Figure 47). SWAT-Check only
reads files in the TxtInOut folder. Therefore, it is important to select the TxtInOut folder of a
particular simulation that one is interested in (e.g. C:\QSWAT_Projects\Robit\Demo\Scenar-
ios\Sim1\TxtInOut). The analysis will be executed by clicking the Examine Model Output
button. Besides executing SWAT-Check, the Setup window provides a summary of the simu-
lation details and watershed characteristics. Moreover, the Setup window provides messages
and warnings that need to be addressed to improve the model simulation.  

Figure 47: SWAT-Check Setup window showing how to run SWAT-Check for a particular simulation.. 

2 The Hydrology window in SWAT-Check summarizes the water balance both graphically and
numerically. It can be accessed by clicking the Hydrology tab at the top of the SWAT-Check
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window. As hydrology is the basis for the landscape processes, particular attention should be
given to modeling the hydrology correctly. Therefore, SWAT-Check will be a vital tool in
providing a quick summary of the hydrological components and as such aids easy under-
standing of the system. For example, it provides the ratios of different water balance compo-
nents. Users can, therefore, compare these values with published literature values, or mea-
sured estimates,  and have an idea how to improve the model performance in subsequent
model calibration processes. Moreover, it gives warnings and suggests methods to address
them (Figure 48).

Figure 48: Graphical and numerical summary of hydrology related SWAT results from SWAT-Check.

3 The  Sediment window summarizes graphically and numerically the sediment yield in the
watershed – both in the upland and in-stream processes (Figure 49). It can be accessed by
clicking the  Sediment  tab at the top of the SWAT-Check window. Sediment loss from the
landscape is affected by many factors. Therefore, summaries of sediment related results from
SWAT-Check can provide insights on how to improve the model performance in simulating
sediment loss in the watershed. For example a quick overview of sediment overestimation
could hint to inadequate biomass production, which could be further examined in the  land
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use summary tab (Figure 50). Moreover, the Sediment tab provides warnings when results
are outside ranges available in the literature. However, results are watershed specific and one
needs to use these warnings as a basis for further re-examination by taking the actual land-
scape processes in the particular study watershed into context. 

Figure 49: SWAT-Check sediment tab that summarizes sediment loss for different landscape processes

4 The Land Use Summary window summarizes the different landscape process components
for each land use type in the watershed. These include hydrology, water quality, sediment
transport and crop growth. The Land Use Summary report can be accessed by clicking the
Land Use Summary tab at the top of the SWAT-Check window. In the case of model cali-
bration, users focus on the watershed outlet, and they may overlook processes taking place in
minor land use types. In such a case, the  Land Use Summary report is very important in
showing where things get wrong in the process of SWAT modeling as it summarizes results
spatially land use by land use. Moreover, it provides warnings related to a particular land use
type so that the users can take appropriate measures. 
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Figure  50:  SWAT-Check  Land  Use  Summary  window  that  summarizes  different  landscape  process
components for each land use type in the watershed.. 

5 This manual mainly focuses on hydrology and sediment related outputs of the SWAT-Check.
However, in studies related to water quality, besides the functions of SWAT-Check discussed
above, Nitrogen Cycle, Phosphorous Cycle, and Landscape Nutrient Loss windows may
be of vital importance. Results from the Plant Growth window of the SWAT-Check will pro-
vide an important guide for users who study agricultural crop yield, and/or biomass yield.
Moreover, the  Plant Growth window provides information about the various crop stresses
(e.g. Nitrogen, Phosphorous, and Temperature). In cases where reservoirs are included in the
management  operations,  the  Reservoirs  window could  provide  important  information  on
reservoir processes. Therefore, all these functionalities in SWAT-Check can be accessed by
clicking the respective SWAT-Check toolbars.  
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6 Appendix I
6.1 Adding tables into SWAT reference database

Tables  need  to  be  added  to  the  local  copy  of  the  SWAT reference  database.  (usersoil and
WGEN_Robit).  

We need to  use a  new  usersoil table  in  the SWAT reference  database.  A local  copy of  this
database was made when the project was started, so that changes to it would not affect other
projects, and would not be lost if we installed a new version of QSWAT3.  If you want to change
this database and use it in several projects you could instead edit the master copy  C:\SWAT\
SWATEditor\Databases\SWATRef2012mdb before  you  create  any  projects,  but  remember  to
reinstate your changes if you install a new version of QSWAT3. 

The  tables  to  be  added  to  the  reference  database  are  usersoil,  using  ExampleDataset\
usersoil.xlsx, and WGEN_Robit, using ExampleDataset\WGEN_Robit.xlsx.   This section shows
how tables can be imported from Excel files. Tables may also be imported by other means. In
particular they may be imported from comma separated value files or copied directly from other
Access databases.

We will use as our first example importing WGEN_Robit.xlsx into the copied reference database.
WGEN  tables define data for simulating weather using a weather generator.  They are used by
SWAT when observed data is missing (either entirely, or on particular dates).  The tables define
data for one or more simulated weather stations.  The SWAT Editor will assign the same station
to all subbasins if there is only one in the table, or find the nearest to each subbasin if there are
more than one.  You can define a new table in the reference database, as we do here, or replace
the dummy data in the existing table WGEN_user. 
 

1 Open the copied reference database C:\QSWAT_Projects\Robit\Demo\SWATRef2012.mdb
in Access.  Select External Data → Import → Excel → Browse to the ExampleDataset
folder where the data to be imported is located, select WGEN_Robit.xlsx and click Open.
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Figure 51: Importing data into SWAT database

2 Select the radio button – Import the source data into table in the current database and
click OK.

3 Follow the wizard - click Next three times, and on the fourth step choose the radio button
No Primary Key  (Figure 52) before clicking  Next.. The table to be appended should
have the same format as the table WGEN_US_FirstOrder in the database.  
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Figure 52: Formatting the table similar to the table WGEN_US_FirstOrder

Name the table with a name starting WGEN (e.g. WGEN_Robit, Figure 53) and click Finish.

Creating the usersoil table in the reference database from ExampleDataset\usersoil.xlsx is very
similar, except that since there is already a table usersoil you will be asked to confirm that you
want to overwrite it.   The table must be called usersoil.
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Figure 53: Naming the table
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6.2 Preparing daily climatic data for QSWAT3

1 The  user  should  initially  prepare  station  information.  The  station  information  should  be
prepared for all the climatic variables for which the user has local data. The header for the
table should consist of columns ID (station ID), NAME, LAT (latitude), LONG (longitude)
and ELEVATION. Refer to the example dataset in the folder ExampleDataset\ClimateRobit,
e.g. pcpRobStation.txt. 

2 The actual climate data should have the same file name as the station NAME in the station
data (e.g. robpcp). The format of the climate data should be as follows: the first line should
be the date in the format yyyymmdd followed by the daily climatic data values. Missing
values are included as -99. The data format for the precipitation, solar radiation, wind speed
and relative humidity is the same. Refer to the example dataset for precipitation in the folder
ExampleDataset\ClimateRobit,  which  is.  robpcp.txt.  The  only  exception  is  for  minimum
temperature  and  maximum  temperature,  in  which  case  the  minimum  temperature  and
maximum  temperature  are  separated  by  a  comma.  Refer  to  the  example  dataset  for
temperature ExampleDataset\ClimateRobit\robtmp.txt. 

3 The actual climatic data should be saved in the same folder as the station files.

4 The units for precipitation, temperature, solar radiation, wind speed and relative humidity
should be mm, degree centigrade, MJ/m², m/s, and decimal fraction, respectively. 

5 For each subbasin, SWAT uses observed climatic data from the closest station. If there is no
observed station climatic data, QSWAT3 will use simulated data using the weather generator.
The  algorithm used by QSWAT3 is  as  follows:  for  example,  suppose  there  are  weather
stations with identifiers A, B and C, and tables Apcp, Bpcp, Atmp, Btmp, and Cslr.  Then the
result will be:
 For precipitation:  subbasins will use measured data from Apcp or Bpcp, according to

whether station A or B is closer.

 For temperature: subbasins will  use measured data from Atmp or Btmp, according to
whether station A or B is closer.

 For solar radiation: all subbasins will use measured data from Cslr.

 For relative humidity: all subbasins will use simulated data.

 For wind speed: all subbasins will use simulated data.
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This makes it easy for users to vary climate data if they wish, and to combine measured data 
from a number of sources. It is even possible to combine simulated and measured data for 
different subbasins: in the example above, for example, if all the values in Apcp are -99 (missing 
data), while Bpcp is measured data, then subbasins nearer to station A will use simulated 
precipitation data and those nearer to B will use measured data.

1.1 Weather generation

When measured data is not available, SWAT uses data simulated by a weather generator program
which uses parameters supplied in weather generator files. The SWAT Editor uses a weather
generator  table,  which  can  contain  the  parameters  for  a  number  of  weather  stations,  each
represented  by  one  line  in  the  table.  An  example  weather  generator  table  (WGEN_user)  is
supplied  with  SWAT  Editor,  in  the  reference  database  QSWATRef2012.mdb  (C:\SWAT\
SWATEditor\Databases).  You can  make your  own such table,  add it  to  the SWAT reference
database with a name starting with the string WGEN.   Use  Write InputTables → Weather
Stations, select the Weather Generator Data tab, and then find WGEN_user in the pull-down
Locations Table menu. It will then appear in this menu. The SWAT Editor will then allocate to
each subbasin the nearest weather generation station from the selected table.

There  is  a  weather  generation  table  covering  the  world  available  from the  SWAT website:
http://swat.tamu.edu/media/99082/cfsr_world.zip.  Install as explained in the pdf file included in
the zip archive, and you will see WGEN_CFSR_World as an option for the Locations Table. 

1.2 Using global data from the SWAT web site

The SWAT web site offers global weather data (http://globalweather.tamu.edu/). In the website,
you can provide the appropriate Lat and Long values for the bounding box of the study area. If
your search with your bounding box  provides you no (or very limited) station data, you might
try a larger search area. You can acquire climate data that ranges from 1/1/1979 to 7/31/2014. It
is good to start at midnight (12.00AM), and also select all five kinds of data. You can receive the
climate data both in SWAT files format and CSV files in a zipped folder. It is sufficient to select
just the SWAT files. The zipped folder will include pcp.txt, rh.txt, solar.txt, tmp.txt, and wind.txt.
These files give details of the weather stations – name, latitude, longitude and elevation.  Use
Write InputTables → Weather Stations, select the Rainfall Data tab, make sure the timestep
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is Daily, and Raingages is checked, navigate to pcp.txt as the Locations Table.  Then select the
Temperature Data tab,  check  Climate Stations and navigate to  tmp.txt.   In similar fashion
choose  rh.txt,  solar.txt,  and  wind.txt in  the  Relative  Humidity,  Solar Radiation, and  Wind
Speed tabs.  Select a WGEN table as described above in the Weather Generator tab, and click
OK.  The SWAT Editor assigns weather stations or gages to subbasins according to proximity
and writes the necessary tables and files. It announces when processing is complete, and you
click OK. 

6.5 Preparing landuse and soil look-up tables

For each landuse or soil map the user can prepare a table like Robit_landuses or Robit_soils and
put it into either C:\SWAT\SWATEditor\Databases\QSWATProj2012.mdb or the project database
Demo.mdb in the  Demo  folder (C:\QSWAT_Projects\Robit\Demo). In the first case it will be
copied into every new project database, but the user must be careful to keep it and replace it
whenever  QSWAT3 is  reinstalled.  In  the  second case  it  will  only be  used  on the  particular
project. The project database is created by copying  QSWATProj2012.mdb  to the  New Project.
Therefore, before Step 1, the user should to add any extra tables that are needed for a particular
project.  But note that it is also possible to have the lookup data for landuse and soil stored in csv
files and to use the Use csv file option the first time the project is run, as described on page 26.

Standard landuse and soil tables, namely global_landuses and global_soils are already included
in the project database.  These are for use with the global landuse and soil maps available from
the WaterBase website on its data page  http://www.waterbase.org/download_data.html.  If you
use these maps then you can use these lookup tables, and the existing tables usersoil, crop, and
urban in the reference database are appropriate. The global maps are in latlong projection and
will need clipping and reprojecting to your project's projection as described for global DEMs in
Appendix II (page 85).

In the case of a landuse map, the table should have the string landuse in its name. Then it will be
offered  as  an  option  for  a  landuse  table.  It  must  have  the  same  structure  as  the  table
global_landuses in  QSWATProj2012.mdb.  So  it  must  contain  at  least  the  columns
LANDUSE_ID  (type  Long  Integer)  and  SWAT_CODE  (type  Text).  The  LANDUSE_ID
corresponds  to  the  values  in  the  landuse  grid.  It  is  possible  that  more  than  one  of  the
LANDUSE_IDs maps to the same SWAT_CODE, where your data makes more distinctions than
are supported by SWAT. The SWAT_CODE strings are (mostly) 4 letters long and all the ones
used in your map must be found in a table crop (or a table urban if the SWAT_CODE starts with
a ‘U’) found in the SWAT reference database.
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In the case of a soil map, the table should have the string soil in its name. Then it will be offered
as  an  option  for  a  soil  table.  You  should  copy  the  structure  of  the  table  global_soils in
QSWATProj2012.mdb. So it must contain at least the columns SOIL_ID (type Long Integer) and
SNAM (type Text).  The SOIL_ID corresponds to the values in the soil  grid.  All the SNAM
strings you use must be found in a table usersoil found in the SWAT reference database.

7 Appendix II – preparing global DEM data for QSWAT3
7.1  Introduction

You may have your own digital elevation map (DEM) for your watershed, but if you don't this
section  explains  how  to  obtain  and  prepare  DEM  data  obtainable  free  from the  web.  The
techniques for clipping and reprojecting DEMs may also be useful for DEMs from other sources.

There are also notes about masking DEMs (Section  7.6) and about dealing with large DEMs
(Section 7.7)  that should be of general interest.

7.2 Obtaining SRTM DEM data

SRTM (Shuttle Radar Topography Mission) is a good source of DEM data for almost anywhere
in the world. It is available at 90 metre and, since the end of 2014, 30 metre resolutions.

The first thing to do is to make a note of the extent of the watershed you want to model: the
maximum  and  minimum  latitudes  and  longitudes.  Decimal  longitudes  that  are  west  of  the
Greenwich meridian should be expressed as negative numbers: if you have a longitude above
180°, subtract 360. Decimal degrees, rather than degrees, minutes and seconds, will be required
for clipping later, so convert yours if necessary (just divide the minutes by 60 and round to 1
decimal place) and make a note of them.

Choose or create a folder for the maps to be stored. We will refer to this as the map folder.

7.2.1 90m data

You might like to use the less detailed 90m data if your watershed is large or if you are new to
QSWAT3. Go to http://srtm.csi.cgiar.org/, and select the SRTM Data Search and Download menu
item. Then select  GeoTiff as  the  file  format.  You can now select  tiles  by selecting  Multiple
Selection and clicking on them, or by selecting Input Coordinates and entering the extent. Then
click Begin Search and on the next page select the Data Download (FTP) or (HTTP) for each of
your tiles. You will not need the mask. Each tile comes in a zipped archive file containing a text
file with information about SRTM (including citation data) and a .tif file, plus .hdr and .tfw files.
Unzip each archive and put the files in the map folder.
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7.2.2 30m data

Go to http://earthexplorer.usgs.gov/ and register if it is your first visit, or log on. You won't be
able to download anything until you are logged on.

Under Coordinates, select Decimal and click Add Coordinate. Enter, the latitude and longitude of
one of the 4 corners of the extent.  Add the other 3 corners similarly. Then above Enter Search
Criteria select the second tab, Data Sets.

Find Digital Elevation, click on the plus sign to expand and find SRTM. Expand that and check
SRTM 1 Arc-Second Global. Then go straight to the fourth tab, Results.

After a few seconds you should see the tiles you need listed. For each one. Click on Download
options (the  5th symbol)  and then  click  Download beside  GeoTIFF.  Save the  file,  close  the
Download Options form, and repeat for each of your tiles. Note that the save form says the file is
a zipped archive, but its extension is .tif and it is not zipped.  Move the .tif files to the map folder.

7.3 Clipping the grids

Start QGIS and load the first grid (using Layer → Data Source Manager, or the corresponding
button on the left of the QGIS window, and selecting the Raster tab). Select Raster → Extraction
→ Clip Raster by Extent  to bring up the Clip form (Figure 54). Select the grid as the Input layer,
select Save to file with the button on the right under Clipped (extent),  use  <grid_name>_clip_ll,
where <grid_name> is some suitable name, as the Clipped (extent) file. It is a good idea to assign
a nodata value, and the appropriate values are -32768 for 90m data and -32767 for 30m data2.
You can find the appropriate value by right clicking on the entry in the Layers panel, selecting
Properties, and selecting the Information tab. The no data value is included in the Bands section,
after Band 1.

Enter the extent you used to download the grids. It is a good idea to widen these somewhat, say
by 0.2 of a degree, to make sure there are no problems.  x here means longitude and y is latitude.
Make a note of the values you use as you may need them again. Check Open output file after
running algorithm and click Run You may get a warning about going outside the raster, which
you can ignore if this is what you expected. Don't close the Clip form, so that you can keep the
no data value and extent. Right click on the original, unclipped grid in the Layers panel, select
Remove layer and confirm. You will be left with the clipped portion. Load each of the other
grids, and clip in the same way. Remember to change the output file name each time or you will

2 The value should not matter, as long as it is different any occurring in the actual data, but if it is different from 
the existing no data value it can cause problems with the existing value being accepted as an actual data value.
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overwrite a previous clip. Close the Clip form when you have clipped all your grids and checked
that the pieces abut to form a rectangle as expected.

Figure 54: Clipping raster by extent
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7.4 Merging the grids
You should have all the clipped grids loaded. Use Raster → Miscellaneous → Merge to open the
Merge form (Figure 55). Click the button on the right under Input layers,  check all the clipped
layers you want to merge, and click OK..  Leave Float32 as the Output data type and again select
Save to file and choose a suitable name, perhaps ending in dem_ll to remind you what it is, and
click  Save. Back in the  Merge form, check  Open output file after running algorithm and click
Run Check the next two messages don't tell you of errors, and click OK to close each of them.

Check your merged DEM is OK by removing the visibility of the other layers. If all is well you
can Close the Merge form.

 

Figure 55: Merging layers
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7.5 Reprojecting the grid

Our final task is to reproject the merged grid into an “equal area” projection, i.e. one in which
each grid cell has the same area.  The current lat-long projection is not appropriate because at
different latitudes the same amounts of longitude will represent different distances. Universal
Transverse Mercator  (UTM) is  a  good general  choice for the new projection.  It  is  available
almost everywhere, and while not exactly an equal area projection is sufficiently close for most
SWAT modelling.  We  need  a  suitable  UTM  zone.  We  can  find  the  zone  from a  map  like
http://www.dmap.co.uk/utmworld.htm, or use the formula  (x + 180)/6 rounded up to the next
integer, for a reasonably central longitude x in our area.  So, for example, if x is -100 the UTM
zone will be 80/6, or 13.3, rounded up, to give 14. Then we note whether we are in the northern
or southern hemisphere.

Use Raster → Projections → Warp (Reproject) to open the Warp (Reproject) form (Figure 57).
Select the merged grid as the  Input layer from the pull-down menu.  Click  Save to file  under
Reprojected and choose suitable name, perhaps ending in dem_utm to remind you what it is. 

Under Source CRS select EPSG:4326 which will probably be the top item since it is the default
project CRS.  The  Target CRS will be  EPSG:326nn where  nn is the UTM zone if it is in the
Northern hemisphere, otherwise  EPSG:327nn.  If the projection is not in the pull-down menu
(which contains projections you have used recently) click the button beside it to bring up the
Coordinate  Reference  System Selector (Figure  56)..   Select  the  appropriate  entry  (there  will

probably only be one if you provided a complete EPSG number) in the Predefined Coordinate
Reference Systems panel, and details of the projection and a map showing its area of application
will be shown.  Click OK.

Leave the Resampling method as Nearest Neighbour.

Enter the same no data value, -32768 for 90m, -32767 for 30m.  Uncheck Open output file after
running algorithm: the projection is different from the current lat-long projection and should be
viewed in a new QGIS window.

Set the Output file resolution to 90 for 90m, 30 for 30m.  This ensures that the output file has
square rather than possibly rectangular cells.

Click Run to perform the reprojection. 
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Figure 56: Select the target SRS
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Figure 57: Reprojecting the DEM

Start a new QGIS instance (leaving the old one in case you find you made an error and need to
redo something).   Load the dem_utm file and check it  looks OK.  Note that the new EPSG
number appears at bottom right, and coordinates in the box at the bottom are now shown as
metres instead of degrees (you won't recognise the numbers but you will see the difference from
the previous instance of QGIS: the numbers will be in hundreds of thousands.)3.  If all looks well

3 If you see degrees instead of metres as the coordinates you should open Project → Project Properties and select 
the CRS tab.  
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close the previous  instance of  QGIS.  Choose  Discard when asked if  you want  to  save the
project.

7.6 Masking a DEM

QSWAT3 does not itself provide a facility for masking a DEM, because the capability is already
in QGIS. Before showing how to mask, a note about when to do it. Masking, or reducing the area
of the DEM to be delineated, is done for two reasons:

 To reduce the amount of time that delineation takes.

 To improve the accuracy of delineation.

The first reason is much less true now than it was some years ago because of the improved speed
of computers. Unless your DEM is very large and detailed it will typically take a few minutes at
most to delineate, and as you don't often repeat the process (and QSWAT3 tries to reduce the
amount  of  recalculation  when  it  is  repeated,  as  well  as  supporting  multi-core  processing)
reducing the area more than the rough clipping described in this document is not likely to be
worth doing. See section 7.7 Large DEMs for more information about large DEMs.

Masking is also dangerous. If after delineation you find that part of your watershed boundary is
on the edge of your DEM then it is quite possible that you have excluded some of the watershed,
and it will be a good idea to reclip the DEM more generously and run again. So the general
advice on masking your DEM is don't do it!

The second reason is much more compelling. DEMs are far from perfect representations of the
real terrain, and delineation can easily include in the watershed areas which are known to be
outside it. In this case, if you have a reliable map of the actual watershed boundary, you can use
it to clip the DEM precisely.  But note you should only do this if necessary: clipping the DEM to
a watershed boundary reduces the probability of accurate delineation at the edges, because slopes
and flow directions at each point are calculated using neighboring points, and at a clipped edge
some neighboring points are not available.

So we assume you have a good map of the watershed boundary, which we assume is a shapefile.
We further assume it is in the projection of your final DEM: if it is in some other projection right
click on the entry in the Layers panel, select Export -> Save as..., and in the next form change the
CRS, browse and select a new file name and click OK. 

We can now use this boundary shapefile to clip our DEM.  Start QGIS, load the projected DEM,
and then load the projected watershed shapefile (Figure 58Error: Reference source not found)
Check the shape lies within the DEM, or we made a mistake somewhere!
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Figure 58: Ready to clip DEM

Then use Raster → Extraction → Clip Raster by Mask Layer to open the Clip form (Figure 59).
If  not  already selected,  select  the  dem_utm from the pull-down menu as  the  input,  and the
shapefile as the mask It is not necessary to set anything else except the output Clipped which you
save as a file such as sj_dem_clip_utm. Click Run.
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Figure 59: Clipping the DEM by mask

Close  the clipper form and remove the dem_utm to check that we have a DEM clipped to the
shape.
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7.7 Large DEMs
Some processing times for large DEMs are shown in Table 1.  These are  not intended to be
anything more than indicative: while the number of cells in a DEM is probably the main factor
influencing processing time,  it  is  not  the  only  one.  DEM sizes  are  in  millions  of  cells:  for
example the 100 million DEM has 10000 rows and 10000 columns. You can see the size of your
DEM by loading it in QGIS, right clicking the entry in the Layers panel and selecting Properties.
The Layer info section under the General tab shows the number of columns and rows.

The  times  in  Table  1  are  for  running  from  after  loading  the  DEM  to  the  end  of  stream
delineation:  this  includes  the  two  most  long-running  TauDEM  functions  (D8FlowDir  and
DinfFlowDir). Note that these two functions only need to be rerun if the DEM changes. If you
want to change the delineation threshold, or the inlets/outlets, the rerun will be much faster than
these times.  Where there is  a second time in brackets,  this  is  for running without  using the
Message Passing Interface (MPI), i.e. with a single process. The machines used to obtain these
figures are:

A A 32-bit  laptop  with  an  Intel  T9400  2.53GHz  processor  with  2  cores  and  2  GB of
memory. MPI was used with 4 processes.

B A 64-bit PC with an Intel i3 3.3GHz processor with 2 cores, 4 logical processors and 6GB
of memory. MPI was used with 8 processes.

C A 64-bit PC with an Intel i7 3.4GHz processor with 4 cores, 8 logical processors and 8GB
of memory. MPI was used with 16 processes.

See Appendix IV (page 100) on installing and using MPI..

Machine/
DEM size

A B C

100 2100(*) 255(560) 104(450)

25 *(480) 64(140) 28(111)

12 159(205) 28(61) 12(48)

6 42(57) 8 (16) 4 (13)

4 13(22) 3(5) 1(3)

2 7(9) 1(2) 1(2)

1 3(4) 1(1) 1(1)

Table 1: Times in minutes for processing large DEMs (sizes in millions of cells)

* - run failed
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There are two conclusions to be drawn from these figures:

 In this range of DEM sizes the times increase initially linearly with the size of the DEM,
but later much more sharply. A DEM of 369 million cells processed on machine C took
over 15 hours, much worse than the rough '1 minute per million cells' that you would
expect for this machine from the table. Typically 'Not Responding' will appear at the top
of the main QGIS window and/or the delineation form. This is a result of the TauDEM
processes running in the background but using almost all the CPU resources. Ignore the
lack of responsiveness and be patient!

 MPI only makes a substantial difference when the DEMs are above a few million cells.
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8 Appendix III: Using a Predefined Watershed and Stream Network
The delineation  form allows  you to  opt  for  a  predefined watershed and  stream network by
selecting the Use existing watershed tab.

On  this  tab  you  can  select  the  shapefiles  containing  the  watershed  and  its  subbasins  (the
Watershed shapefile) and the stream network (the  Streams shapefile). These files need to have
the same projection as the DEM. If you want to use files generated by TauDEM in a previous
project, then such files can be found in the Sources subfolder of that project, with names ending
wshed.shp and net.shp respectively.

It is also possible, but not necessary, to specify an Outlets/Inlets shapefile, and again a file from
the previous project may be used. If such a file is not specified, only main outlet(s) from the
watershed will be used as main outlets in the new project. You will not be able to mark inlets, but
you will later be able to add reservoirs and/or point sources to existing subbasins.

The  watershed shapefile must be a polygon shapefile (each polygon representing a subbasin)
with the following fields:

Necessary/Optional Name Type

Necessary PolygonID Integer

Optional Area Double

Optional Subbasin Integer

The streams shapefile must be a line shapefile (each line representing a stream reach) with the
following fields:

Necessary/Optional Name Type

Necessary WSNO Integer

Necessary LINKNO Integer

Necessary DSLINKNO Integer

Optional DSNODEID Integer

Optional Length Double
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Optional Drop Double

An outlets/inlets shapefile must be a point shapefile with the following fields:

Necessary/Optional Name Type

Necessary ID Integer

Necessary RES Integer

Necessary INLET Integer

Necessary PTSOURCE Integer

Necessary fields must be defined in the original files. Optional fields may or may not be defined
originally. With two exceptions defined below, if optional fields are defined, and if the  Reuse
button is checked then their values will be assumed to be correct and reused. If optional fields are
not  defined originally,  or  if  the  Recalculate  button  is  checked,  then  they  will  be  defined if
necessary, calculated, and the calculated values inserted4. Any file may have other fields defined:
these will be ignored. The fields may be in any order.

The first exception is the DSNODEID field. This is  necessary if an outlets/inlets shapefile is
specified, in which case it is assumed to be correct and its non-negative values must refer to ID
values in that file. DSNODEID values are never recalculated.

The second exception is the Subbasin field in the watershed shapefile. Even if present and Reuse
is selected it is checked to have suitable values for the SWAT basin numbers. These must be
strictly positive and form a consecutive ascending sequence starting from 1, except for basins
which are empty, when the Subbasin values must be zero. If the Subbasin values do not meet
these requirements they are recalculated.

There  are  some  conditions  imposed  on  the  fields.  The  PolygonID values  in  the  watershed
shapefile must be unique, non-negative, and must equal the corresponding WSNO values in the
streams shapefile: each subbasin must have exactly one stream reach, and each stream reach
(unless  it  is  zero  length5)  must  have  exactly  one  subbasin.  These  two  fields  provide  the
connection between the subbasins and the stream reaches. The LINKNO values must also be
unique  and non-negative  (and will  typically  but  not  necessarily  be  the  same as  the  WSNO
numbers.). The DSLINKNO (downstream link) values must each be another LINKNO value or -

4 Changes to these files are only made to the copies of the originals in the Source folder of the project.
5     Zero length reaches are used to enable triple stream junctions.
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1, where -1 indicates a watershed outlet. Files previously generated by TauDEM will meet all
these conditions, and their values may be safely reused.

There is also an assumption made about the stream reach shapefile. Each stream reach is a single
line,  represented as a  sequence of  points.  The first  point  in  the sequence may represent  the
upstream (source) end and the last represent the downstream (outlet) end, or vice versa. TauDEM
creates stream reaches with the first point at the outlet end, but either orientation is accepted by
QSWAT3. The assumption is that the orientation is the same for all the reaches. The orientation
is checked by finding a reach with an upstream or downstream reach where the ends of the
reaches are within one dem cell of each other: normally such ends will exactly coincide.

The optional fields are (if necessary) calculated as follows:

Field Calculation

Area The area of the subbasin in square metres.

Subbasin For subbasins which are not empty and not upstream of an inlet, a unique
number from the contiguous sequence 1 .. n, where n is the number of
such subbasins.  These will be the subbasin numbers for use by SWAT.
For subbasins which are empty or upstream of an inlet, 0.

Length The total length in metres of the straight line segments forming the reach.

Drop The  absolute  difference  in  metres  between  the  elevations  of  the  end
points of the reach.

Note that if a predefined watershed and stream network is chosen then the length of the stream
reach in each subbasin will be used for the maximum flow length in that subbasin.

1.3

99



9 Appendix IV:  Installing and Using MPI 

QSWAT3   uses  TauDEM,  Terrain  Analysis  Using  Digital  Elevation  Maps,  as  the  main
component for doing watershed delineation.

The current version of TauDEM is designed for modern multicore architectures. A  multicore
CPU has more than one processor: 2, 4, even more. By using an implementation of the Message
Passing Interface (MPI), TauDEM can take advantage of multiple cores, splitting tasks into
several  processes  distributed  between  them,  and  speeding  up  calculations.  It  is  also  able
(provided your machine has enough memory) to process very large DEMs..

The  implementation  of  MPI  used  by  the  windows  version  of  TauDEM  is  MS-MPI from
Microsoft, which is free to download and use.

By default MS-MPI is not installed when you install QSWAT3: TauDEM will run without it, in
"single process" mode.

You may obtain and install MS-MPI, and we give some instructions below. Then QSWAT3 will
take advantage of it.  There is no point in doing this unless you have a multicore CPU, and
probably not much unless you have large DEMs: see Table 1 in Appendix II for some examples
of processing times on large DEMs.

It is possible the first time you run one of the TauDEM executables after installing MS-MPI that
you get a TauDEM error, and in the details you will see

Fatal protocol error: check version between Mpiexec.exe, Msmpi.dll, and Smpd.exe.

The way to fix this is to remove or make inaccessible the copy of msmpi.dll that is stored with
the TauDEM executables in order to enable them to run without MS-MPI. Go to the folder C:\
SWAT\SWATEditor\Taudem5Bin and rename  msmpi.dll to, say,  msmpidll (which is better than
removal as you can restore it later if necessary).

9.1 Installing MS-MPI

Note that you need to be an administrator to install MS-MPI.

 Download the MS-MPI installer MSMpiSetup.exe from
http://msdn.microsoft.com/en-us/library/bb524831%28v=vs.85%29.aspx and install it.

 Restart the machine (otherwise it will not be able to find the executable mpiexec.exe).
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 On  a  32-bit  machine  there  can  be  a  problem  installing  and  running  MS-MPI.  If
MSMPISetup will not run you need the 2008 version: see below. If the installer runs,
after  restarting  your  machine  you should  check all  is  OK by opening a  command
window and  running  the  command  mpiexec  -help.  If  there  is  an  error  saying that
mpiexec is not a valid 32-bit command then download and install the 2008 version of
MS-MPI from http://www.microsoft.com/en-gb/download/details.aspx?id=14737.

9.2 Configuring QSWAT3 to use MPI

On the QSWAT3 main screen there is a QSWAT parameters button.  Clicking this enables users
to set the locations of the SWAT Editor (by default  C:\SWAT\SWATEditor) and of  mpiexec.exe
(by default  C:\Program Files\Microsoft MPI\Bin).   Users should also make sure  Use MPI is
checked: this is checked by default if the MPI Bin folder exists.  Then MPI will be used during
watershed delineation provided the  Number of processes spinbox in the  Delineate watershed
form is set to some positive number.  This should be left at zero if MPI is not installed.  See
Table 1 in Appendix II for some example times for large DEMs on different machines with
typical settings of the number of processes.

9.3 Blocking network access  

MS-MPI  supports  multi-process  computations  across  several  machines.  So  you  may  get  a
Windows firewall query as to whether you want to allow the MS-MPI program manager, smpd,
access to networks (Figure 60). Since TauDEM only runs multiple processes inside your machine
you may Cancel access (unless, of course, you are using MS-MPI for other purposes for which it
needs network access).

Separate TauDEM executables (D8FlowDir,  DInfFlowDir, etc) may also raise the same query,
which is annoying - but it only happens the first time you use them!
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Figure 60: Cancelling network access for MPI

102



10 Appendix V:  Converting ArcSWAT Projects to QSWAT3

10.1 Purpose

The purpose of this tool is to help users migrate from using ArcSWAT to using QSWAT3.  In
particular it enables ArcSWAT users to use the visualisation capabilities of QSWAT3, using their
existing output data.    As well as reading this guide, users will also need to acquaint themselves
with QGIS 3 and QSWAT3 documentation.   It assumes users have downloaded and installed
QGIS 3 and QSWAT3 according to the instructions in this manual. 

The essential steps in QSWAT3 are much the same as ArcSWAT.  Creating the model consists of
first delineating the watershed, then combining the delineated watershed with landuse and soil
data, and defining HRUs.  At this point the work with GIS is complete and the SWAT  Editor is
used to add weather data, edit inputs as required, and then run SWAT.  QSWAT3 uses the same
SWAT Editor as ArcSWAT, so this step will be familiar to users.  After running SWAT, the editor
can be used to save the SWAT outputs in an output database, and the features of QSWAT3's
visualisation  module  are  available.   If  the  output  database  was  created  within  ArcSWAT,
visualisation is enabled as soon as conversion is complete.

The conversion tool has three particular purposes in mind, for which it offers Full , Existing, and
Edit, run, or visualise options.

Full conversion is for users who want to rebuild their ArcSWAT project from scratch.
After conversion, they will be at the start of their SWAT project, about to do watershed
delineation.  The data they need that could be collected from the ArcSWAT project: the
maps, soil data, weather data, etc. will be available, and they will be able to create a
model as close to or as different from their ArcSWAT project as they wish.

Existing conversion is  an option for those who aim to keep their  model  as  close as
possible to the ArcSWAT one.  An immediate problem with shifting from ArcGIS to
QGIS  is  that  the  watershed  delineation  software  is  different,  and  can  give  different
results.  Watershed boundaries may shift, streams may move, the numbers and boundaries
of  subbasins  may change.   To avoid this,  the  existing  option  uses  the  subbasins  and
streams generated from ArcGIS as an existing watershed, and so preserves the watershed
boundary, the streams and the subbasins.   Adding landuse and soil maps is done within
QSWAT3, as is HRU calculation, so the details of HRUs may differ from the ArcSWAT
model.  
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Edit, run, or visualise conversion is mainly an option for users who just want to run
QSWAT3 visualisation  on their existing models without any preparation like delineation
or defining HRUs.  Nothing is done in GIS, so the subbasins , streams and HRUs are not
changed.  After conversion QSWAT3 can be used to immediately start the SWAT Editor,
the same SWAT Editor as used in ArcSWAT, so users may if they wish edit their inputs
(inherited directly from ArcSWAT), rerun SWAT and save outputs, and use visualisation.
Or they can save their ArcSWAT outputs in the output database, if not already saved, and
run  QSWAT3  visualisation.   Or,  if  the  SWAT  output  was  already  saved,  they  can
immediately start QSWAT3 visualisation.

The conversion tool copies much of the ArcSWAT project,  and then changes the contents of
some copied files, but it does not affect any of the files in the ArcSWAT  project.  Nor does it rely
on them afterwards: QSWAT3 always maintains the files it uses within its own project structure.
So your ArcSWAT project is safe, and you can change it or delete it later without affecting the
QSWAT3 project.

10.2 Instructions

10.2.1 Prerequisites

You will need to install QSWAT3 and the SWAT Editor from the SWAT website, together with
QGIS 3, a 32-bit version as instructed in this manual.

10.2.2 Conversion

Run  C:\SWAT\SWATEditor\runConvertFromArc.bat by  double-clicking  on  it  or  using  it  as  a
command in a command or shell window.    If you didn't use a command or shell window one
will open, and you will see messages there as the conversion progresses.
You  will  see  an  initial  message  about  Untested  Windows  version  6.2  which  can  be  safely
ignored.
You will be asked to locate the existing  ArcSWAT project directory.  You can recognise you are
in the right place as this directory will contain within it at least the directories called Watershed,
Scenarios,  and  RasterStore.idb.   Then you are  asked to  identify  a  parent  directory  for  your
QSWAT3 project.  This should be an existing directory (though you can create one on the fly if
you wish).  Note that you are not selecting the QSWAT3 project directory, since this is about to
be created,  but only where that project directory is  to be placed.  Do not try to arrange the
ArcSWAT and QSWAT3 parent directories so that one is a descendant of the other, as this would
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cause problems (and the tool will prevent you in any case). 
 
Once you have selected the parent directory you will be invited to reuse the ArcSWAT project
name or create a new one.  Once the name is chosen, the tool checks to see if the QSWAT3
project directory exists already.  If it does, the tool checks that you wish to delete it, and does so
if you confirm that it should.  

Deletion of an existing directory to make the QSWAT3  project directory sometimes seems to
fail, with a message being displayed  to say so.  Sometimes this message appears although the
deletion has in fact taken place.  If this happens you can do the following:

 Check with File Explorer if the directory exists and if so use File Explorer to delete it.

 If there is still a problem, check that there is nothing else (like another File Explorer win-
dow) accessing the directory or one below it.

 Open the Task Manager (right click in the taskbar to find it), switch to the Details tab, and
kill any processes with name  python.exe  or  python3.exe.  Python processes seem often
not to die when they are exited.

 If all else fails and you still cannot delete a directory, reboot the machine. 

When  the QSWAT3 project directory has been created, as a directory with the project name
within the parent directory, the conversion tool creates all the subdirectories needed, and copies
the ArcSWAT project and reference databases., and creates a QSWAT3 project file (X.qgz in the
parent directory, where X  is the project name).

Then the conversion tool opens a  form for you to make the choice between Full, Existing, or
Edit, run, or visualise conversion.

If you choose Full or Existing, the DEM, landuse and soil rasters and shapefile maps from the
ArcSWAT project are copied,  rasters into Source (for the DEM), Source\Landuse or Source\Soil
and shapefiles into Watershed\Shapes.   In this process the DEM is converted to a GeoTiff, as
this is required by QSWAT3 delineation.

QSWAT3 normally uses two shapefiles to mark points.  The first is the inlets/outlets shapefile
and includes the main outlet(s) and any inlets that were defined in the ArcSWAT model.  Note
the Monitoring Points shapefile generated by ArcSWAT includes points at stream junctions as
well as main outlets and any extra points defined by the user.  QSWAT3  does not include in its
inlets/outlets shapefile the points which are stream junctions: they are implicit in the model.  This
means that  if  you have marked any additional  points  as  monitoring points (and which have
created subbasin boundaries) and are using the Full option you will need to add them by hand:
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QSWAT3 includes a facility for adding more outlets manually.

If you are using the  Full option, delineation will use the inlets/outlets shapefile.  It is possible
that some points in that file will not snap to the stream network that QSWAT3 calculates.  If this
happens, you can fix it either by editing the inlets/outlets shapefile using the shapefile editing
capabilities of QGIS, and dragging the affected points to their streams, or it may be sufficient to
increase the snap threshold from its default value of 300m.

The second points shapefile used by QSWAT3 is the extra inlets/outlets shapefile, which defines
any reservoirs and point sources.  If you use the  Full option and have reservoirs and/or point
sources you will need to do the following when you delineate your watershed:

 Complete  the Create watershed step

 If you have reservoirs, click on  Select reservoir subbasins.   The subbasins which are
highlighted will almost certainly not be the ones in which your reservoirs are placed.
This is because the subbasin numbers generated by QSWAT3 will be different from those
generated previously by ArcSWAT.  Click on the map canvas outside the watershed to
clear the subbasins selection, then hold Ctrl and click in the subbasins where you can see
the reservoirs are to be placed.  Click Save to exit the selection form.

 If you want to add point sources, make sure the Add point source to each subbasin option
is checked,.

 Click Add.

 QSWAT3 marks the reservoirs near the subbasin outlets and the point sources near the
subbasin inlets or stream sources.  

If you use the Existing option the inlets/outlets shapefile is not used.  The subbasins shapefile
from ArcSWAT is  used  as   the  Watershed shapefile,  and the  stream network is  used  as  the
Streams shapefile.    Since we also use the subbasin numbering from ArcSWAT, reservoirs and
point sources should be correctly placed: no correction as with the Full option is necessary.  The
conversion tool adds the attributes required by QSWAT3  to the various shapefiles, so running
the delineation form should involve no more than clicking Run and then OK.

The conversion of the subbasins and streams shapefiles to QSWAT3 can generate warnings about
values not being copied because fields are not large enough.  It seems that these warnings can be
safely ignored.
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1.4 Landuse and soil data

For both Full and Existing options, the landuse and soil maps from ArcSWAT are copied.   We
also need the relevant lookup tables (unless the soil map is SSURGO).  Users are invited to
choose to use their own comma separated value (csv) file for each of landuse and soil if they
have one (they can  supply it when they run QSWAT3).  Otherwise the following procedure is
used to create lookup tables:

 The landuse and soil maps are read, and percentages of each value occurring in them are
calculated.

 The percentages of the watershed for each landuse and soil are read from the ArcSWAT
project's LanduseSoilsReport.txt

 The two lists  are matched by being placed in  descending order  of percentage,  which
should give the relation between map value and landuse or soil name that comprises the
lookup table.  

 If  the  lengths  of  the  lists  differ  the  percentages  from  the  map  are  reported  in
landuse_map_percentages.txt  or  soil_map_percentages.txt which  is  placed  in  the
QSWAT3 project directory for  manual comparison with the ArcSWAT LanduseSoilsRe-
port.txt, and no csv file is generated.

 If consecutive percentages in a list differ by less than one percent, or if percentages in
corresponding lists differ by more than one percent, the user gets a warning message.  If
there are percentages which are themselves less than one percent, the user is also warned.

 The csv files are saved as landuse_lookup.csv and soil_lookup.csv in the project direct-
ory.

 When, later, QSWAT3  is run there is an option Use csv for the landuse and soil lookup
tables which allows these files to be read (and stored as database tables for future runs of
QSWAT3).   In the meantime users can inspect these files and correct them if necessary.
This will certainly be necessary if in the ArcSWAT project more than one map value was
mapped to the same soil or landuse.

The landuse and soil maps saved in the ArcSWAT project have been clipped to the ArcSWAT
watershed  boundary.   This  is  convenient  for  creating  lookup  tables,  since  the  percentages
calculated from maps are correct for the watershed, but a disadvantage when using the  Full
option as the QSWAT3 watershed may not agree precisely with the ArcSWAT one.   QSWAT3
will report if the percentage of the watershed covered by the landuse or soil map falls below
95%.  If this happens users should, if possible, replace the landuse and soil maps with unclipped
maps.  QSWAT3 does not initially create HRUs where soil or landuse is not defined, but it will
later enlarge all HRUs proportionately so that their total area is the same as the watershed. So
falling below this 95% threshold may not be too much of a problem if the unclipped maps are not

107



available.

After conversion is complete, you are invited to run QGIS on the converted project immediately.
If you select  Yes QGIS will start.  The new project is already selected, but you won't see any
maps displayed: they will be loaded when you click the  QSWAT button.  Then if the  Full or
Existing option was chosen the DEM will be loaded.  With the Full option the inlets/outlets file
will also be loaded, and with the Existing option the watershed and streams shapefiles will be
loaded, plus any extra inlets/outlets file showing point sources and reservoirs.  You are ready to
click on Delineate Watershed and the appropriate tab for doing a new or existing delineation will
be selected.  If the  Edit, run or visualise option was chosen the  Edit Inputs and Run SWAT
button will be enabled, with which you can start the SWAT Editor.  For all three options,  if there
is already an output database copied from the ArcSWAT project in Scenarios\Default\TablesOut
the Visualise button will be enabled and can be used to visualise the ArcSWAT project's outputs.
If the Full or Existing option was selected, and the ArcSWAT project had an output database in
its  Scenarios\Default\TablesOut directory, then an extra scenario  ArcSim (or if  ArcSim  exists,
ArcSimn where n is a number chosen to make a new directory) is created as a copy of Default.
This protects the shapefiles from ArcSWAT, which were copied to be used in visualisation, from
being overwritten when running delineation or creating HRUs within QSWAT3.   ArcSim(n) is
therefore the appropriate scenario to use when visualising ArcSWAT outputs after using the Full
or Existing conversion option.

1.5 Other data

For all three options (Full, Existing,   and  Edit, run, or visualise) and for each scenario the
ArcSWAT  TxtInOut   directory is  copied as it  is into the QSWAT3 project.   This means that
weather  generator,  observed weather,  reference data,  inlet,  reservoir  and point  source data  is
preserved.  It also includes file.cio, which contains the start and end dates, plus the NYSKIP value
for the simulation.

Note that for the Full option inlet, reservoir and point source data files may need to be renamed
for  the  different subbasin numbers generated by QSWAT3.   Visual comparison of the QGIS
and  ArcSWAT models  is  probably  the  easiest  way  to  see  how  the  subbasin  numbers  have
changed.
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